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Chapter 1

Introductions
“If you could live your dreams and draw your fantasies, 
wouldn’t you?”

Sometime in elementary school, I ripped out a Dewar’s 
Scotch Whiskey ad from a magazine and posted it on the 
wall of my bedroom. Dewar’s had a series of ads profiling 
cool people, and this one was of Denys Cowan, an artist for 
DC Comics. That quote appeared in the ad under the 
heading: WHY I DO WHAT I DO. I haven’t forgotten it since. 
It was like a question a mythological god would ask back to 
someone asking them a question. It was the perfect answer 
for an impressionable young artist to read. That ad never 
made me want to try drinking Scotch (sorry, Dewar’s), but 
that single quote made me feel like living out my dreams 
when I was older was just an obvious path to follow. Denys’ 
profile also listed his age, and I’m currently 3 years older 
than he was back when the ad ran. So the days of me 
being “older”, have been ticking for a while. The question 
then is, do I currently live my dreams and draw my 
fantasies? Well, I’m an independent artist and programmer 
but most importantly, this is a job I love, so yes, I think 
Denys would be proud.

If you aren’t working a job you love, or even enjoy, then this 
book is for you. You need to start doing something fun, 
maybe at first as a hobby, but in the long run, as a career. 

Linda
May -Lee

Paul

Below we have some new students joining the 
section headers of this book. The purple haired one 
is not new, he just slipped in with some hair dye. 
The other three ended up resembling people I 
know, so I’ll name them accordingly...

Can my 
name be
 J-Rod?
Or no, is 
Fill-Up 
a cool 
name? Hi!



Ouch, kind of a biting question to begin with, but a fair one. In 
2004, I started a company called CartoonSmart.com, which 
specializes in video tutorials for all kinds of art software and 
programming languages. Just recently, Animation Career Review 
put us in the Top 100 Animation Sites You Need To Know.  
Proudly, we are number 30 on that list. I should accept that honor 
backstage though, because in recent years I’ve hired very 
talented instructors to teach our animation courses. I taught our 
early Flash ones, but now I teach more of the “smart” stuff in the 
programming department. Fortunately, I get to watch a lot of 
animation lessons from CartoonSmart’s teachers, so in writing 
this book, I’ll get to return to my roots with some new tricks. 

In a past life, I was an Animation Director for a mid-size studio in 
Manhattan. This studio is long gone now but before the internet 
bubble burst, the company had some very generous angel 
investors that let us make web cartoons at the whim of the 
owner. Whatever he wanted, we did, and when I told him we 
needed more people for such-and-such project, he found more 
money. I told him that a lot, so we grew rapidly from a very small 
studio (at first, I was the only animator) into a company with 
about 30 animators. One might think, “Justin, you were probably 
just promoted to that position because you were the first 

animator there.” To that I would say, “Hold on a moment, I need 
to use the restroom.” Then you would hear a window opening, 
footsteps, and tires squealing off into the distance. 

I’ll be honest, it still sounds good to say I was an Animation 
Director, so I throw that former title around when need be (which 
is rare but I backed myself into a corner with this section title). 
My studio days really were a past life. We definitely broke some 
ground with Flash before it was generally regarded as an 
animation program, but these days I’m just happy to be a humble 
instructor. Like a dealer that doesn’t get high on his own supply, 
I’ll teach you how, but you won’t find me working in an animation 
studio, much less running one, ever again. Every year I spent 
trying to get a group of straight-out-of-college animators to keep 
to a weekly schedule aged me like 10 normal years, so while I’m 
technically in my thirties, my body thinks I’m around 65. 

I have that job to thank for inspiring me to start CartoonSmart. I 
enjoyed teaching the new people we hired how to animate our 
way, which was definitely fake animation. We cut corners to 
save time and stay sane, but we also succeeded in telling some 
fantastic short stories. To me, that’s good fake animation, but 
let’s define that term a bit better for your needs.

Section 1

Why Are You Learning From Me?
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If you stumbled onto a book titled “How to Fake Great 
Animation” and that interested you enough to buy it or simply 
preview it, I doubt you’re reading this to make a feature film, or 
even a polished short film. Whatever you’re planning to do, I’m 
guessing you don’t have many (or any) co-conspirators to help 
out. I bet you don’t even have the time to draw a thousand 
frames. Or even a hundred. Is it safe to assume you suffer 
from both limited time and limited help?

If so, then welcome to the non-exclusive club of Do-It-Yourself, 
Work-Alone-From-Home Animators. Other members like yourself 
are hobbyists, enthusiasts, dreamers, gamers (both makers and 
players), pranksters, and storytellers. Name a reason for wanting 
to quickly animate something, and we’ve got a member in the 
club already here for that very reason. We don’t want slow pokes 
though. If you are happy committing 2 or 3 years of your life, 
working in oil on canvas to paint every frame of your animation, I 
don’t think you’ll fit in.  

Here is the perfect timeframe for your next animated scene: one 
evening. Not an entire day, not a caffeine-glazed all-nighter. Just 
one evening. Six o’clock to midnight.  You won’t lose sleep, you 

won’t be late for work the next day. You’ll continue your happy 
existence in society without suffering for your secret double-life 
as an animator. I mean, fake animator. 

Real animators were made to suffer. Those traditionalists, 
drawing frame after frame after frame, have it tough. I should say 
“had” it tough. Technology is made to wipe out tediously cruel 
jobs. Like sewing. Pitting olives. Performing in a play. You can’t 
turn on the TV without noticing there’s fewer of those traditional 
animators around anymore. Wherever those people were once 
employed, be it Disney’s film department or a small company 
making Captain Crunch commercials, they are some place else 
now. Hopefully they are enjoying a similar job with the aid of a 
computer because talented animators can usually take their 
talents to other mediums. 

Character design for cartoons has changed too with the use of 
computers. Many of the cheaper-made cartoons use the same 
library of pre-made illustrations in each episode to animate the 
character.  No one can argue that drawing or modeling 
something once and using it over and over again saves time.  For 
better or worse, the design of the character plays an important 
part in how well that library of parts is used in production.

Section 2

What is Great “Fake” Animation?
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So at the risk of peer-pressuring you with a “C’mon McFly, 
everyone is doing it” type pitch, I’ll just say this.... Come on. 
Everyone is doing it. All animators are computer animators now. 
The great news is that the bar has been lowered so far, even by 
the big studios, YOU can now make great animation from your 
home. By great, I mean, pretty decent stuff, all things considered.

Making pretty decent stuff will usually be fine depending on your 
usage. Why are you posing like an animator this week?  School 
project? Business proposal? Splash-screen for a video game? 
Short special effect for a friend’s direct-to-nobody video? 
Elaborate joke for Facebook? All those reasons are 100% valid 
for resorting to fake animation. Not bad, just fake. I don’t want 
you to ever aim so low you come off as doing it badly, but your 
usage might determine that subtle grey area between what’s bad 
and what’s passable. If you somehow got a job for AMC theaters 
doing a “Please Silence Your Cell Phone” cartoon before every 
single showing, then maybe it’s time to reconsider your game 
plan for the project. Working alone in your basement office won’t 
cut it. Your limited resources and limited help are more of a brick 
wall than the literal brick wall in back of your monitor. That’s a 
good problem though. If you land a “real” job, then you have 
some “real” money to spread around and hire more help. This 
book might help whatever A-Team you hire, but let’s be real, if 
that day comes, I hope you hire guys that already know their 
craft. This book is primarily for you new animators, working more 
niche projects. 

Embrace the word “fake” as something good. Imitation is the 
sincerest form of flattery, right? I’m sure growing up you 
“sincerely” asked your Mom to make your brother or sister stop 
saying everything you said. In the grown-up world, a fake, or 
imitation is a replica of something better, but the replica itself can 
be pretty darn good. Like imitation crab meat. It’s still super tasty, 
but it’s just not real crab meat. It’s flavored to taste the same. 
“Flavored” is a good word for us to use in this book. It has better 
implications. If you feel like your attempt at a great animation is 
still too fake, then we will simply flavor it some more. This book 
will hopefully teach you exactly that: the quick seasoning to make 
your best effort good enough to be called “great” by the 
untrained eyes of most people you’ll ever show your work to. In 
the end, if most of your audience is impressed, I think by 
definition, you’ve done something impressive.

Less talk, more animation

I’m going to share one of my earliest Flash animations. I’m proud 
to say it took me less than a day to make and I even snuck in 
some work hours to do it. Normally I wouldn’t recommend that, 
but the animation was based on a true event that happened to 
the vice president of the company I worked for at the time (also a 
good friend who provided a twisted version of his own voice) To 
me, this is the perfect example of fake animation. The 
entertainment payoff from it has far exceeded the cost in time to 
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make it by about a billion percent. I still post this on my former 
VP’s Facebook wall anytime I can find the slightest reason to. 

Tap the embedded movie or here to play online. If you laughed 
at all at that, you 
should know Roda did 
get pretty hurt from 
that fall. Shame on 
you.... Just kidding, 
anytime a person buys 
an expensive new 
sweater with holes in it, 
some angry God of 
Sweaters is just 

waiting for that person to walk down slippery steps. 

Now it’s self critique time. You should always step back from 
your work and give yourself an honest critique. Even a decade 
later. Applaud what you did right, and try to find something you 
did wrong too. It is possible to be proud and critical of yourself at 
the same time.  

The Good: It is funny. Somehow this still makes me laugh. 
There’s something about the timing that worked really well. You 
know what’s going to happen, it happens, it’s over, and if you 
laughed, you might actually watch again.  It’s a banana-peel gag, 
which are formulaically funny for the same reason babies find 

things funny. Fear. At least that’s what my kids laugh at: almost 
getting dropped, peek-a-boo, drift racing, etc.   

The Bad: It was obviously put together quickly. Some of the lip 
sync isn’t perfect. There really isn’t that much animation aside 
from the lips moving. Looking back on the backgrounds now, I 
would illustrate those completely different. I did this in Flash 4 or 
Flash 5, and things have changed quite a lot since the year 2000 
(yeah, it’s that old). The program has long since had Filters to blur 
vector art, and backgrounds generally look better blurred to give 
them an out-of-focus feel. I see some areas that could be shaded 
better. So my main critique now just boils down to me being 
different. If I did this today, it would be done by a different person, 
I’m a better illustrator and animator than I was a decade ago. 
Plain and simple. Does “Roda’s New Sweater” need a Hollywood-
style remake?....Yes. Yes it does. 

Despite it’s shortcomings, this piece served it’s purpose perfectly. 
Which was simply to retell a funny story. It’s like a cheap toy that 
eventually breaks. The design might have had flaws but it was fun 
while it lasted. And isn’t that what defines something as 
worthwhile? 

This chapter section is titled, “What is Great Fake Animation?” 
and I think this is your answer: the animation’s entertainment 
value outweighs it’s imperfections, making it worth watching to 
it’s target audience. 
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There are dozens of terrific animation programs, to name a few: 
Adobe After Effects, Adobe Flash Professional, Toon Boom 
Animate, and Toon Boom Studio. If you’re lucky enough to 
already have any of those, I won’t try too hard to steer you 
toward one or another. What you animate with is your choice and 
for the most part, this book will be focusing on tricks and tips 
that can be applied to almost any program. The early chapters 
will have some very specific instruction for Adobe Flash, but later 
on the instruction will be more broad, and I think whatever 
program you choose will be fine. You could even use a program 
that doesn’t include a timeline, like Photoshop, Illustrator, or 
Sketchbook Pro. Reason being, if you only need 10 frames of 
animation for say, the intro screen of an app you’re working on, 
those frames will most likely end up as a sequence of PNG or 
JPG images (like intro1.png, intro2.png, etc) so rendering them 
together as a movie file isn’t necessary. Even if you are working 
in a dedicated animation program, you’ll still export image 
sequences for many of your projects. So while it’s absolutely 
preferable to use a program with a timeline to scrub back and 
forth to preview your animation, in some cases, you can get 
away with working in an illustration-only program.  Also there’s 
times when we could harness the Batch Actions in Adobe 

Photoshop to make mass changes to hundreds or even 
thousands of frames at once, so we might intentionally switch to 
a non-animation program. The point is, the program I use most 
often in this book, doesn’t have to be your first choice. 

With that long preamble taken into account, many of my loyal 
students from CartoonSmart.com can already guess I’ll be using 
Adobe Flash Professional for this book. I originally intended to 
write this book for both Flash and Toon Boom Animate, but 
looking at my ever-growing “To-Teach” list, I don’t think I can 
squeeze in two separate programs (but that’ll give me a reason 
to write a dedicated book on Animate). My personal workflow is 
a bit faster with Flash since I’ve been using it so long, but 
Animate is definitely the more professional animation program of 
the two. Kind of like the more talented offspring of Flash. In fact, 
on Toon Boom’s website they actually pitch Animate as “The 
Most Reliable Flash Animator’s Companion”. I think this is a great 
description because it embraces that Animate should appeal to 
Flash users that have gotten accustomed to a certain style of 
illustrating and animating (and don’t want to lose that) but 
haven’t seen significant improvements to it’s professional 
animation capabilities over many versions. Flash still falls short in 

Section 3
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some export options (albeit Flash CS6 continues improving this), 
functional inverse kinematics, a true “camera”, and a broader 
range of filters. With that said, Flash is not just an animation 
program. Take a look at what Adobe sums up Flash as...  
 
“Flash Professional - 
Interactive experiences, 
game design & mobile 
device packaging”

In my best Don Draper voice, can I just say, “I don’t think I read 
the word ‘animation’ once in there”. How odd then that you’re 
reading a book on animation using a program that skirts around 
declaring itself for animation. I can explain if you’re interested. If 
you aren’t interested, but you’re still drinking your coffee and 
don’t want to commit to actually working yet today, you can read 
my unabridged thoughts on the state of Flash, which for Adobe 
geeks like me, are exciting times. 

The Flash Program is Not the Flash Player

The Flash authoring program (what I’ll be using to animate with) 
got dragged through the mud a little when Apple decided not to 
support the Flash Player on iOS devices. The iPhones and iPads 
still don’t run Flash Player in Safari, and ever since this standoff 
started tech-bloggers have either mourned or rejoiced the death 
of Flash Player. That really has nothing to do with the Flash 

authoring program itself though. Flash Player is a browser plugin 
which plays one of many formats published from Flash, a swf file. 
As anyone with a regularly-used iOS device knows, you can 
survive online without seeing Flash-made content in a browser. At 
times, you might feel like you’ve burned the stairwell to keep a 
zombie horde from attacking you on the second floor, but like I 
said, you can survive (you just can’t get to the entertainment 
console in the living room). Despite the Flash Player vs. Apple 
dust up, the Adobe Flash authoring software is stronger than ever 
and used by professionals in some pretty big industries. Ironically, 
one of which is app development for iOS. Say what??

Adobe Flash can now package (fancy word for export) 
applications for both iOS and Android devices. This is still a 
relatively new feature of the program, and Adobe is headed in the 
right direction by making this possible. A lot of the web 
developers that relied on exporting to Flash Player had a nerve-
wracking couple of years recently, but they were rewarded by 
becoming app developers overnight because of Flash’s new 
packaging abilities (these publish options were tested with Flash 
CS5 and officially included with Flash CS5.5).   

Another thing Flash is used for professionally is animation. I live in 
Atlanta, GA which has surprisingly turned into one of the 
animation hubs in this country with so many of Turner’s properties 
located here, a S.C.A.D. campus, and other studios that enjoy our 
fair weather safely away from large bodies of water (fictionally, our 
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major threats are zombies in The Walking Dead and those water-
allergic aliens from the movie Signs would love it here). Recently I 
met an animator working on Archer, that spy cartoon on FX, who  
told me his studio mostly uses Flash. This surprised me because 
I’m still a little stuck in the year 2000, when I used Flash 4 to 
make cheap web cartoons, and some part of me still sees it as a 
crude animation tool for a professional studio. Granted, I use the 
program everyday for something or other, so when I say “crude” 
that isn’t a slam to Flash (I love it), I just don’t see CartoonSmart 
as a professional studio. Frankly, it’s not, I’ve been working alone 
in a home office for almost a decade. So I’m impressed when I 
hear the same program that little old me tinkers in is also used by 
real studios to make broadcast cartoons. 

Point is, Flash is kind of a “jack of all trades” software. It’s 
tempting to complete the adage, and say, “jack of all trades, 
master of none,” but I can’t. Flash did master in-browser 
interactive content and games with Flash Player for a loooong 
time, but Adobe is retooling the software for a new era that 
doesn’t rely solely on desktop browsers. I think developers will 
soon have one Flash source file that exports an app for Android, 
an app for iOS, a swf for Flash Player, and also an HTML5 
version. Granted, this book is for animation, so we won’t be 
touching on those topics, but if you do decide to use Flash, you 
can easily step into application or interactive content 
development using your same source files. 

You Read the Good, Is There a Bad?  

When Adobe bought Flash from Macromedia many years ago, I 
really hoped we would see Flash become essentially what Toon 
Boom Animate is today: a full-featured animation program with a 
real camera and inverse kinematics (that are suited for more than 
just construction cranes). I’m guessing Adobe struggled a little in 
determining the future of the software when they took the reigns 
from Macromedia because of us animators, a minority group of 
users, that wanted it to be so much more. Adobe bought a 
program that was being used three-fold: web design, game 
development and animation. At that time, every user was 
primarily publishing to Flash Player to display their work on the 
web. I think if anyone at Adobe was seriously pushing to advance 
the animation features in Flash, they ran into a brick wall because 
the Flash Player would need to support those changes and play 
them back well within the browser.  With Flash’s future grounded 
more today in app packaging, it will be interesting to see what 
new animation features we get. What’s in the program now is 
great (well worth writing a book about), but there’s a lot of things 
in gaming engines that could also be used for animation. For 
example, built in particle FX, like rain, snow, or fire, would be a 
great addition for both game developers and animators. What can 
I say? Every software user dreams of the next version’s features.

Speaking of versions, I’ll be using Flash CS6, but for the most 
part, what I teach applies to Flash CS3 and up.  
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Alrighty, it’s time to journey onward. We’ve got a fun road ahead 
to say the least. This is an animation book, not a programming 
book. You can relax and put your feet up higher than your 
shoulders for a lot of this trip. We’ve got dozens of topics, each 
with example movies and source files ready to help us out. How 
many animation books actually have animations on their pages? 
Cool, right.

Although if you happen to get a 
copy of this book that doesn’t 
support embedded movies (like 
the PDF version), you’ll want to 
visit the Resources page on 
CartoonSmart. Feel free free to bookmark it now, but there are 
plenty of links to it throughout the book... 
 

 CartoonSmart.com/Animation_Book1/Resources.php5

 
 
That link will have alternate copies of the movies and zips of 
source files so you can work on the same projects I teach here. 

Just remember, if you’re reading this from your iPad, you can’t 
download a zip file to it. You’ll need to switch over to your Mac or 
PC. Source files will open fine for either operating system. 

Movie files in the Resources section will play via HTML5 embed 
code, so anyone using a recently updated browser (like Chrome, 
Firefox, Safari) should be fine to watch these on a range of 
computers and devices (including iOS). Of course, if you’re 
reading this on your iPad or iPad mini, all the movie files are 
embedded and ready to play from the book itself. 

Finally, you do not need a Wacom tablet or anything fancier than 
a mouse to draw with, at least for what I’ll teach in this book. I’ve 
been illustrating professionally with Flash for a looooong time, 
and I’ve used a Wacom tablet for about 2 hours total during that 
span. I’m a vector illustrator, and the mouse has always been 
easier to work with for me. I also think for non-illustrators, 
meaning those of you that think you can’t draw, you’ll be 
surprised to learn that you probably can draw a little using just 
the mouse and Flash. Vector illustration is completely different 
than traditional illustration. You’ll see what I mean later.

Section 4

Resources
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For buyers reading this on their iPad or iPad mini in the iBooks 
format, you can request an alternate PDF copy from 
CartoonSmart.com. The PDF version can be read from your Mac, 
PC, or any other device which supports the Adobe Acrobat 
format. The PDF version does not include embedded movies 
(instead it links to them in the browser), the Interactive Images do 
not zoom to highlight areas of the image, and while Glossary 
terms are included in the back of the PDF, they are not active 
links like they are in the iBooks format. So if you are fortunate 
enough to be reading the book in the native format, I recommend 
you stick with it. If you would like a copy of the PDF anyway, feel 
free to email me.

In the subject or body of your email, include the answer to this 
secret question:

What words are tattooed on Linda’s arm at the 
beginning of Chapter 3?

This is the first paid page of the book, so if you are viewing the 
free preview don’t go crazy trying to find Chapter 3. Instead, do 
us a solid and consider purchasing this book. 

Section 5

Reading on Your Mac or PC 
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Chapter 2

Motion 
Posters
For our first real chapter, I’d like to take a slightly 
different approach than the dusty animation books 
on my shelves. They begin by animating the 
character. I’d like to begin with what’s around the 
character. An animated atmosphere can do as 
much (or more) to convey a mood than the facial 
expressions or movements of a character. 

Hollywood has started releasing “motion posters” 
online to get some early hype for new movies. They 
are exactly what you’d expect with that name. A 
poster with motion, which sounds like a good 
project for us because the term implies we’re 
mixing static images with moving ones. In our 
poster, we’ll leave the main character unmoved. So 
this will hopefully be a softer introduction to 
animation than asking you to jump in head first with 
a walk cycle right away. 

The center piece of 
our motion poster. 
He looks excited.



Queue up your best montage music for a 
“suiting up” sequence. Tie that head band and 
high five everybody before the big mission. On 
a freelance gig, more often than not, you’ll get 
some assets provided to you. In the early 00’s, 
I made a lot of Flash banners and I’d usually 
get a small image of a TV or something 
electronic which I would base an animation 
around. It wasn’t much art, but it was always 
better than hearing a client say, “Can you just 
draw a TV for this?” Of course, for your own 
personal projects you’ll probably be the only 
one feeding yourself artwork to use. That 
doesn’t mean though you need to be 100% 
responsible for your creative assets.  

The internet has an amazing amount of 
buyable artwork, also known as royalty-free 
stock art. You’re probably thinking, “I didn’t 
buy this book, to go buy artwork,” and I’ll 
agree that goes against my usual do-it-yourself 
philosophy, but the occasional bought art is 

actually cost-effective if it saves you eight 
hours of labor. When I need something, I like to 
browse a site like iStockPhoto and narrow my 
search to just the Illustrations or Flash section 
and preferably just the vector art. You can treat 
your search like an inspiration quest, just to get  
ideas, but if you find a piece that you think 
would be absolutely perfect, you’ve always got 
the option to purchase it. 

So let’s look at what we’ve got for our project. 
Obviously you saw our fully shaded poster 
character on the previous page, and here he is 
again, except this time you’re seeing the 
unglamorous vector shapes which define him. 
These shapes are just made up of connected 
points which are filled in with a color. You’ll 
learn how to draw with vector points soon 
enough, the important thing to realize now is 
that our character is not a pixel-based 
illustration, he’s a vector-based illustration 
(vectors are easier to animate).

Section 1

Assets Investigation
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So I can stop calling him “our character” let’s give him a good, 
strong Italian name like, Anthony. Or maybe just Tony for short. 
Tony is our centerpiece. As such, he’s not really built for movement. 
There are ways to draw a character in Flash that facilitate motion, 
but this is not one of those illustrations. Aside from a couple 
separated parts (the head and arm), Tony is mostly a big chunk of 
art. That’s okay though because he won’t be moving in this motion 
poster.

Alright readers, here’s my Hot-or-Not test... is Tony an “okay” 
illustration or what? Can your author still put mouse to pad and 
draw? I spend a lot of my hours programming these days, so 
maybe I’ve lost some of my former glory in the art department. 

I don’t hear anyone screaming “YOU CAN’T DRAW NO MORE!” so I’ll 
assume I can still put a modest character into Flash. Which makes me feel 
much better about using a stock background. I found a piece with a 
turnpike-looking road and city that was just too perfect to try to recreate on 
my own. For under $100, I was happy to pay the license fee and call it a 
night. The only thing I needed was a completely different mood from the 
original. So you can see the changes I’ve made here. I darkened the 
original, blurred it, and added a sky (which was a blurred image from my 
iPhoto library). When I get to actually demonstrating some techniques we’ll 
talk plenty about darkening and blurring assets so don’t think I’m skipping 
over something you need to know right now. 

So let’s combine our assets together on the next page, and take a look at 
our static poster, which is our starting point for this project.
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Pretty cool, right? Let’s make it much cooler with these animated 
add-ons...

• Title, I’ve left room on top for us to add a title to our fake movie.

• Cigar smoke, we can’t have a character burning a stogie without 
smoke. I’m not endorsing smoking, but I am endorsing animating 
smoke. In your lifetime as an animator you’ll work with a lot of 
smoke. How many times did Wiley Coyote blow up or Scooby 
Doo run off leaving a trail of smoke puffs? Heck I’ve even seen 
Spongebob explode and smoke billows up afterwards, and he’s 
UNDERWATER! I’ve also seen him take a bath too...again, 
underwater. Very odd. 

• Cars, we can’t have an oversized mob boss just standing on an 
empty road, we need some freeway action to accentuate the 
large imposition that Tony is causing. 

• Background City Noise, we’ll add some subtle life to the city 
with an animated billboard, someone pacing in a window, a 
helicopter flying around, and some police lights.

• Eyes Blinking, I said we wouldn’t be doing any character 
animation, but I think you’ll see that a simple blink actually adds a 
lot to make a static character more alive. Nothing says dead like 
unblinking eyes. That’ll be all we do to Tony though. One frame 
change. 

• Fade Out, so our project has an end to it, we’ll fade to black.
14



For Extra Credit - you could play around with animating Tony’s face with more than 
just a blink. In the picture to the right, each of the pieces of artwork that make up Tony’s 
face is animatable. They are all selected in the image, which is why you see so many 
blue boxes. This is just so you get an idea of each part, for example, eye lids, brows, 
ears, etc. Every one of those parts could be key framed over time, or exchanged with 
another part. So even though the previous images of Tony might have seemed like his 
head was one continuous piece of art, it’s actually made up of 20-30 containers, or 
Symbols as they are called in Flash.

Is your montage music ready, because now’s the time to play it. Get your Chapter 2 
assets at the usual Resources page.  
 
I’ll provide PNG files for the images if you are working in a program other than Flash, 
otherwise just open the tony_start.fla file where the art has already been imported.

If you feel like you’ve already got a good handle on the general interface of Flash and 
why you would use a Movie Clip over a Graphic Clip, you can skip this next section and 
jump into our movie poster project. Otherwise, you’ll definitely want to pay attention to 
the upcoming section: Introduction to Flash.
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If this is your first time 
using Flash, I’m very 
excited to impose my 
personal preferences 
on you. First off, no 
application should have 
their Tools Panel on 
the far right, which is 
the default layout if 
you’ve never used 
Flash. I’d really prefer you switch your interface layout to the 
Classic setting. You’ll see this option in the top right of the 
screen. This is going to set the interface to the same workspace 
layout that I use (which will be shown throughout this book in 
images or movies).  

Next, let’s make sure you can set your hot keys. From the top left 
Flash menu, select Keyboard Shortcuts. Create a new set by 
pressing Duplicate Set (mine are named Justin), then under the 
Commands pulldown, select Drawing Menu Commands. You 
can now choose from any of the commands in the top menu of 
Flash (not just “drawing” related ones). Then if you switch 
Drawing Menu Commands to Tools Panel, you can set keys for 

any of those. Since each tool already has a hot key, you might 
just want to review what selects what. As a personal preference,  
with every new version of Flash I install, I switch the hot keys for 
the Select Arrow and Subselection Arrow (diagrammed below).  
Don’t feel like you have to do that too, but try to commit to 
memory either the shortcut A or shortcut V to hot key the 
primary Select tool (the black arrow).

Section 2

Introduction to Flash
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Filters

Blending Effects

Color Effects

Timeline Scrubber and How to Extend a Layer’s Timeframe

Layer Management

Tools Panel

Blank Keyframe

Keyframe

What’s Currently Selected

Properties Window

Next let’s give you a light introduction to the general interface. Flash can be used for many things, so I’ll just highlight the essential parts that you 
should take notice of as an animator. Below I’ve labeled one of the start files for this project, so I’ve already added some of the artwork and 
placed it on layers of the timeline. Tap each of the labels below for a short description (or read them on the next page if you’ve got a PDF 
copy of this book). If there’s some unfamiliar terms like Movie Clip or Graphic Clip, I’ll define them properly soon enough. 



Timeline Scrubber and How to Extend a Layer’s Timeframe - 
This pinkish bar that rests on frame 1 displays the frame you are 
at. Right now my timeline is showing about 82 frames but my 
published movie would only have ONE actual frame to it at the 
moment. I would need to extend the timespan on some or all of 
my existing layers to lengthen this animation. Selecting a frame 
somewhere further out in the timeline and pressing F5 would do 
what’s called Inserting Frames, which extends that layer’s time. 
These are not keyframes or blank frames, they are just time 
extensions of the existing frame. You can also right click on a 
layer and select Insert Frame.

Blank Keyframe - A frame without anything on it appears blank 
like the one pointed to in the label. You could press F7 or right 
click on a layer and select Insert Blank Keyframe to clear out 
that frame.

Keyframe - Keyframes, or frames which contain objects, appear 
filled in like the one pointed to in the label. A keyframe might be 
“keying” many objects or just a single object. Every layer with 
artwork or a symbol will at least have one initial keyframe like 
this. The position, scale, rotation, filter effects, etc, are all set for 
frame 1. Other frames could then be keyed with different 
transformations. F6 is the hotkey to create a new keyframe or 
you could right click on a frame and select Insert Keyframe. 

Layer Management - You can add a new layer to the timeline by 
clicking the icon on the far left (below the timeline layer names). 
New layers obviously won’t contain any artwork, so you’ll just see 
a blank keyframe on it (like many of the layers in this example 
screenshot).

The middle icon creates a folder which could be used to organize 
your layers. Once created, just drag existing layers into the folder. 
You could then collapse the folder to minimize what you see on 
the timeline.  

When a layer is selected you can trash it (and the layer’s 
contents) by pressing the trash icon.

Tools Panel - I like this window to have two columns, so if you 
want to be like me, hover over the side of the window and pull it 
wider (if you’re only seeing one column). This window contains all 
your tools. Compared to many programs, it’s really not that many 
tools, but some of them pulldown to reveal more options. We will 
explore most of these later as we begin to draw and animate.
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What’s Currently Selected - Symbols in Flash will have a blue 
bounding box around them if they are selected onstage. Aside 
from just clicking an object onstage, you can select a keyframe in 
the timeline and see which objects have this box around them, 
indicating that not only are they selected, but they are also on 
that particular layer. It’s easy to forget which objects are on which 
layer. Selecting all the objects on a layer by keyframe can be an 
easy way to move, scale or rotate them all at once, so organizing 
your layers by character or by particular body regions can be 
helpful.

Properties Window - This window should be ever-present in your 
production, as you’ll be doing something with it frequently. Many 
properties can be set here, for example Color Effect, Display 
Settings, Positions and Filters to name a few. 

Tabbed behind it is the Library window, which we will talk plenty 
about later, but in short, the Library contains all your Movie Clips 
or Graphic Clips (your saved artwork / animation) and other 
imported files (like images or audio clips).

Color Effects - You can change basic color and alpha settings 
with this pull down menu. Like everything in the Properties 
Window, changes you make here apply to the current keyframe.  
Color Effects are an option for both Movie Clips or Graphic Clips, 
but not raw vector artwork.  

Blending Effects - This is one of my favorite pull down menus to 
experiment with for interesting effects. I also have a hunch it is 
one of the lesser used properties in Flash, but hopefully this book 
will change that. Blending Effects can be applied to Movie Clips 
but not Graphic Clips or raw vector artwork.

Filters - This was a fantastic addition to Flash a long time ago. 
Sadly, we haven’t seen a new Filter since this panel first showed 
up, but the ones we do have are pretty solid. This includes Drop 
Shadow, Blur, Glow, Bevel, Gradient Glow, Gradient Bevel and 
Adjust Color. Filters can be applied to Movie Clips, but not 
Graphic Clips or raw vector art.

19



Movie Clips and Graphic Clips

As far as animation is concerned Flash has two primary 
containers for your artwork. These are Movie Clips and Graphic 
Clips, which can both be called Symbols in Flash. If you were to 
draw a simple square or circle onto the stage, this would just be 
vector artwork. Most often when we animate something, we’ll 
want to convert that artwork to a symbol first. This could be 
done by selecting the vector art and tapping the keyboard 
shortcut F8.  You could also right click the art and select 
Convert to Symbol or go through the Modify menu and select 
Convert to Symbol. Trust me, pressing F8 is worth 
remembering. Once you choose to convert artwork to a symbol, 
you’ll need to choose the type. We’ll pick either Movie Clip or 
Graphic, but there is another option, Button, which won’t come 
into play in this book.

You’ll probably want to give the symbol a name appropriate to 
what it represents instead of just “Symbol 1” or angrily banging a 
string of characters on your keyboard like “ashfjkdsasd”.  
Symbols, whether they are Movie Clips or Graphics Clips, will 

end up in the Library of the Flash 
file. The Library plays an 
important part in your life as a 
Flash animator because this is re-
usable artwork now. So anytime 
you need a copy, or instance, of 
a previously-created symbol, you 
can return to the Library and pull 
it back onto the stage. This 
archive of art is what essentially 
defines Flash-style animation or 
cut-out style animation. There 
are plenty of animators that don’t 
animate with Flash in this fashion, 
they take a more traditional 
approach by drawing on a frame, 
going to the next frame, drawing 
something different, and so on, never keeping copies of their 
past frames or parts of frames to use again. This “tradigital” 
approach isn’t what popularized Flash as an animation tool 
though. Having quick access to reusable art, like mouth gestures 
or hand poses, from a library gave us efficient (ahem, lazy) 
animators a modern cut-out style animation program. Before 
computers, cut-out style was exactly what it sounds like, “cut 
out” pieces of art (like with scissors) were moved around each 
frame in small steps to save time drawing those same parts 
again. The first South Park animation was done this way with 
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actual paper (in college, a friend of mine showed me a bootleg 
VHS tape of it, long before it was ever on Comedy Central).

Traditional animators have always considered the cut-out style to 
be a lesser approach to animation, and it’s not easy to argue that, 
because it is definitely a quicker, cheaper style. That doesn’t 
mean our end result will look like Blue’s Clues or South Park, 
because remember we’re trying to fake great animation. So at 
times, reusing many of the same parts will work fine, other times 
we’ll need to spend time making each frame unique. 

We have a lot more to discuss with Movie Clips and Graphic 
Clips, but I’m going to interrupt that discussion with a sub section 
to really highlight a point about your library symbols...

Changing a Symbol Changes Every Instance

Read that, and make it flash over and over again in your brain 
with bright neon lights. If you created a square, converted it to a 
symbol, then made 10 copies of that symbol (just by copying and 
pasting them on stage), and then changed the original artwork of 
one of them, they will all change. Keep in mind, only the internal 
contents of the symbol affect other copies. So external 
transformations to the symbol, like changing the position, scale, 
rotation, color effects, do nothing to other copies. Only those 
changes you make within the symbol, affect all instances. You 
should see this in action with a movie, since it is a pretty key 
concept to animating with Flash. 

 

 
Hopefully you took note of the keyboard shortcut Command/
Ctrl + E (Command for the Mac, Control for Windows). This is 
how to Edit a Selected Symbol. You could also double click a 
symbol to edit it. In Edit Mode, you’ll have access to that 
symbol’s internal timeline as well as the original vector art or other 
contents within. Symbols can contain other symbols, imported 
images, code, essentially anything the main timeline could have 
on it. They are a universe within a universe. Sounds confusing at 
first, but you’ll soon learn why symbols are so cool because of 
this.

Movie 2.1 
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Movie Clips vs. Graphic Clips

Both types of symbols have their own timelines, which are nice 
organizationally, because it allows us to group entire events into one 
symbol. Keep in mind, we could have multiple copies of an animated 
symbol on stage, so for something like rain drops hitting the ground, 
we could put those water splashes into a symbol, paste it 100 times 
around the scene and then stagger the starting point for each splash. 
Some might begin immediately, others might begin at a blank frame 
which eventually loops back to the first frame to start the splash 
animation. This is a key concept: symbols with animation loop by 
default. This feature can really be harnessed to achieve some 
amazing effects.

For new Flash users, you’ll probably have a tough time choosing 
whether to use a Graphic or Movie Clip. This is an important decision, 
so I’ve recorded another tutorial movie to help you out. In this video, 
I’ll create a looping animation that looks much better as a Movie Clip 
because of the Filters applied to it. Filters can’t be applied to a 
Graphic Clips, so that’s a big “win” for Movie Clips, but as you’ll see at 
the end of the movie, only the animation from a Graphic Clip can be 
seen while scrubbing the main timeline. That’s only an inconvenience 
during development, where this really matters is when you export an 
image sequence of your finished animation.  Movie Clips still stay at 
their first frame. For most versions of Flash, you’ll need to export a 
Quicktime Movie of your final piece if you use Movie Clips, although 
Flash CS6 now gives you the option to export a single Movie Clip with 
Filters as an image sequence.  

Movie 2.2 

Movie Clip Graphic Clip

Can loop Yes Yes

Can loop if the main timeline is 
stopped at a single frame. Yes No

Scrubbing the main timeline will show 
animation within the symbol No Yes

Can have Filters or  
Blending applied to it Yes No

Exports to a PNG Sequence Pre-CS6: No  
CS6: Yes Yes

Exports to a Quicktime Movie Yes Yes

Can start at a frame other than 1 Yes /w code Yes

Can be controlled with Actionscript Yes No
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Duplicate a Symbol vs. Copying a Symbol

Yes, there’s a difference. A big difference. I’ve been teaching 
Flash video tutorials for quite a while, and I know from countless 
frantic emails that new students to Flash struggle with this. I 
already mentioned that changing one symbol’s contents also 
changes every other instance of that symbol, which at times is to 
your benefit. Sometimes though you just want a copy of that 
Graphic or Movie Clip which you can alter without changing the 
original or it’s instances. You can right click a symbol, and find 
Duplicate Symbol or go to Modify> Symbol > Duplicate 
Symbol or even better, assign the shortcut Command/Ctrl + D in 
your keyboard preferences. Doing so, would override an existing 
hot key for Edit > Duplicate. That’s right folks, Duplicate and 
Duplicate Symbol are two different commands! The first one I 
think isn’t worthy of a hot key, since everyone already knows the 
universal hot keys for copy and paste anyway, which is all 
Duplicate does. With a Duplicate Symbol command, you’ll see 
the image below pop up. Give the symbol a new Library name, 
and you’re good to go. Like I said, I know this is confusing, but try 
to lock in this concept now, and it’s smooth sailing from here.  
 

Swapping Symbols and (sigh) Groups

We probably won’t do much symbol swapping until we work on 
character animation, but while we are going over the basics of 
using symbols, this is an important thing to learn. Suppose you 
were animating a lip sequence and needed to swap out one 
mouth for another mouth symbol, over and over and over again. It 
would get very tiresome to drag out a new symbol from the 
Library and reposition it. Instead you could right click and find 
Swap Symbol or go to Modify > Symbol > Swap Symbol. You 
can then pick out any other symbol in the Library to replace the 
current one on stage in the same position. As usual, you’ll speed 
things up by learning a shortcut for Swap Symbol. By default, 
there isn’t one, so I would love for you to set one right now for 
two reasons. 

First, obviously it’s faster. Second, the custom one I use overrides 
the hot key for Group, which is shortcut Command/Ctrl + G. 
Why pick on Group? Well grouping is used in many graphic 
programs, and it’s fairly harmless. You group and ungroup things 
whenever. Often times just to aid in the authoring environment 
and it has no effect on much else at all. The problem with a group 
in Flash is that it can appear similar to a symbol (with a bounding 
box around the group) and be key framed. So a new animator 
might assume they are keying a symbol, then go to change 
something slightly within the symbol, thinking it will affect all 
previous frames, but instead it only affects that particular frame of 
the group. Some animators can use this to their advantage, but in 
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my experience it can lead to trouble. I’ll give you a good 
example....  

 
After keying the Eight ball a few times, I double-clicked into the 
group, recolored it, changed an “8” to a “3” with a little digital 
White Out, and wah-la, it’s a Three ball! Except when I scrubbed 
back the timeline, the Eight balls are all still there. My Three ball 
changes had no effect on past groupings of that artwork. Now 
imagine if instead of a few frames, I had keyed 100 frames. 
Obviously with a symbol, this wouldn’t have been a problem at all 
because our first rule of Flash Club is “Change one, change all”. 

General Workflow Tips

If you go to the Flash > Preferences menu, you’ll see an option 
called Contact-sensitive Selection and Lasso tools. I have to 
disable this. This is a pretty deep-seeded preference for me, but 
more recent users to the program will not have ever known things 
differently, so maybe you can function with it on. I can’t. 

Movie 2.3
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With Contact-sensitive Selection and Lasso tools disabled 
you’ll select symbols by click-dragging around the entire object. 
With it enabled, click dragging a portion of the stage will select 
every object you came in contact with. If that’s how you are used 
to working, perhaps from another program, then you might as 
well go with what you know. Usually this won’t matter when you 
are selecting a single object, because either way simply clicking 
the object still selects it. This is more of a preference for how you 
select multiple objects. I find it easier to select multiples by click-
dragging around more of an area than less. Otherwise a small 
selection area might select way more symbols than you imagined 
were touching that area. 

Like all graphic programs, you’ll be zooming 
in or out constantly, so get familiar with the 
Magnifier (Zoom) tool. The shortcut Z 
switches to it by default (just remember Z is 
for Zoom). Like most other programs this tool can be used to 
zoom in or out by pressing a modifier key, on the Mac this is the 
Option key, on Windows this is Control. 

Pressing shortcut Command/Ctrl + 1, sends the stage back to 
viewing your art at 100% zoom.

Pressing shortcut Command/Ctrl + 2, zooms the stage to fill 
your current work area.

Pressing the Spacebar on the keyboard turns the mouse to a 
hand so you can move the stage/work area around. 

Pressing the Enter key on Windows or the Return key on the 
Mac is a shortcut to play the timeline (if you have more than 
one frame). 

Pressing Control + Enter on Windows or Command + Return on 
the Mac is a shortcut to test publish movie. You could also do 
this by going to the Control menu and finding Test Movie. This is 
drastically different than just playing the timeline, because you’re 
actually publishing a .swf file and previewing it. Code would run, 
and more importantly for us animators, Movie Clips would play 
normally. 

The shortcuts to step forward or backward on the timeline use 
either the < key or > key (the keys with the less than or greater 
than symbols, aka, the comma and period keys). 

Phew! That should be enough general “interfacing” to get you 
started with Flash. I don’t want to give you a full list of hot-keys 
because no one can possibly remember them all on Day 1 
anyway. They are helpful though, so if you want to double-check 
which ones I think are most important, go to the Glossary of this 
book, and scroll down to the word “shortcut”. All my entries for 
important shortcuts will be found there. 
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Let’s get started on our real project and begin modifying 
the tony_start.fla file. The perspective-heavy freeway at 
Tony’s feet gives us a great opportunity to add some 
easily animated cars. We won’t even bother drawing 
cars though because that could backfire by looking too 
repetitive or just downright cheesy. Instead we’ll just 
show the taillights / headlights trailing by and since we 
won’t display more than 5 to 10 frames for each car, this 
will probably appear more like time-lapse film of a 
freeway. So stylistically this could look pretty good. We 
could slow down each car (and if you want that’s up to 
you) but the finished effect is a nice juxtaposition 
considering we have a fast paced city with an imposing 
slow-smoking figure on top. The Boss is taking his time, 
not intimidated by modern life. At least, that can be our 
excuse for animating this quickly. It’s okay to be 
efficient and justify that as an “artistic vision”, as long as 
what you do looks good at the end of the day. 

I’m going to use Movie Clips throughout this project 
because a lot of what I do will look much better with 
Filters. Despite the export issues, Movie Clips can be 

used in some really fun ways and 
for a small project like this we 
might as well embrace them. 

We’ll begin by drawing the entire 
trail of light from one car. This will 
be nothing more than a white 
square that has been curved in 
perspective. I can show you this 
best with the short video to the 
right.  

Section 3

Key-Framing Freeway Lights
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Movie 2.4 

Three Quick Steps to Vector Illustration in Flash...

• Draw a rectangle with the Rectangle Tool

• With the Selection Tool (the one with the black arrow, not the white arrow) roll 
over the corners of the rectangle and move the invisible vector points to 
reshape it. When hovering over a vector point, the mouse cursor will have a 
small right-angle next to it. 

• To bend the lines between vector points, roll over the side of the shape and 
click drag around. When hovering between vectors, the mouse cursor will have 
a small curved line next to it.

This reminds 
me of Tron... he 
took me to see 

the movie 
Tron.

Tap above to play or here to view in a browser
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Once your shape is ready, select it and convert it to a symbol by pressing F8. 
Be sure the Type is set to Movie Clip and for the Name property you can call 
it whatever you like (I’ll go with freeway_light1).

Now select the symbol, then in the Properties Window find the Display 
section, and under the pulldown menu for Blending, select Add. This blend 
mode gives a nice boost to the trail. If you want a more official definition for 
what Add does, Wikipedia tells me “this blend mode adds pixel values of one 
layer with another” to the point that we just see white.   

Next, in the Filters panel we will add two Glow filters. The order we apply the 
two glows will matter, one will be an inner glow, which adds the effect to the 
inside of the art, whereas the normal glow adds the effect to the outside. It’s 
probably easier to add two Glows at once, then make your Filters panel look 
identical to mine in the screen shot to the right. Matching up the numbers is 
easy, and to speed things up, you can hit the Tab key on the keyboard to skip 
down to the next value field while you are entering them. Just don’t forget to 
toggle on the Inner Glow box on the blue glow. 

Obviously I’d like your end result to look similar to mine, but you should 
experiment a little while you are playing around in this window. Change the 
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color, blur more on the X or Y axis, alter the overall strength of the 
effect, etc. Of course you can also change the white color of the 
vector art to something different as well. Mine has a slight hint of 
yellow. So have some fun with this.  Here’s what I went with... 

 
 
That’s quite a leap from the very plain vector shape we started 
with. Now all we need to do is animate it. 

Double click the symbol so you are in Edit Mode. You should be 
seeing the original un-filtered vector art again. Next, keyframe the 
art by hitting shortcut F6 until 
the 10th frame is keyed. It 
might seem strange to key the 
same vector art over and over 
again like this. Maybe you 

assumed we would be 
taking a more linear 
approach to the 
animation by starting in 
the distance, then key 
framing slight 
movements we made 
to the vector points 
down to the bottom. 
Well, we could. It’s just 
much faster (and 
probably better 
looking) to delete the 
portion we don’t need 
from each identical 
frame. I think doing this 
the other way would 
result in a slight wiggle 
since pulling the 
vectors on our own 
would be far from perfect. 

All you need to do now is select a portion, hit Delete on the 
keyboard, then hit the > key to go to the next frame. Repeat that 
in a similar fashion to what you see in the image above. Try to 
leave one frame in the middle unaltered. There’s two reasons it’s a 
good idea to leave one of the frames in mint condition.  First, it 

28



obviously gives us a fallback copy of the original art in case we 
need to create new frames from it. Second, we can insert frames 
at that point, which will lengthen the animation. Note we are just 
inserting time, not more key frames. Do this yourself by selecting 
that unchanged frame and pressing the shortcut F5 three or four 
times. Your timeline should look like the image below now. 

If you were to double-click the stage now, you would be taken 
back up to the main timeline, leaving the freeway_light1 symbol 
timeline, where again we have just one frame on the timeline. This 
is perfectly fine. For this project, we won’t add any extra frames 
to the main timeline because 
we will use Movie Clips for all 
our animation. There’s one 
issue now, which is that we 
are only seeing the first frame 
of our freeway_light1 
animation and if yours looks 
anything like mine, that means 
you’re only seeing a small sliver of the vector art. This is just a 
personal preference, but I would rather see our original drawing in 
case I want to play around with the Glow filters again. As you can 
see in the example image, the Glows look quite different on a 

smaller portion of vector art, so using that as reference isn’t a 
good indication of how the entire piece will look. Again, this is 
only if I want to work back on the Glows again, but as an artist (or 
“arteest”) you should give yourself every opportunity to improve 
your work, even if it’s just slightly. So let’s rearrange our frames 
within the symbol, and while we are doing that, let’s also add 
some blank space in the middle of the first and second half of our 
frame sequence. On the timeline this will give us a small gap, but 
to anyone viewing this as a loop it won’t be noticeable.
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• Press shortcut F7 on the 
keyboard to add a blank keyframe

• Press F5 on the keyboard to 
insert more frames

• Click and drag the first 5 frames, 
then release. This will select them.

• Click down on the selected 
frames and drag them forward

• Select from frame 5 to the blank 
keyframe

• Now drag this group of frames to 
the beginning of the timeline



Now you should have the original 
art back at frame 1 and if you 
were to go to Control > Test 
Movie > Test (or press 
Command/Ctrl + Enter on the 
keyboard), you would see the 
animation running endlessly with a small break between each 
loop where nothing appears on screen. 

It’s possible to have a Movie Clip with a blank keyframe on the 
first frame, but this becomes a bit of a nuisance in the authoring 
environment because there’s nothing on stage for you to see or 
click on when you want to edit it. If I have a reason to do this, I’ll 
usually just drag some dummy artwork off stage on frame 1, so 
when I publish, the frame is essentially invisible, but during 
development I can easily find the symbol.

Now I want you to work within that same symbol again and create 
slight variations of what we’ve already done. You can recycle 
some of the same frames by right-clicking and using the Copy/
Paste Frames commands or create an entirely new vector trail to 
add even more variation. My suggestion would be to keep this 
Movie Clip’s light trail limited to a single highway lane. This will 
ensure that our looping clip will never veer into another car. Since 
each lane could have another Movie Clip looping independently, 
we do not want to try to time them together to avoid cars 
colliding. It’s much easier to just keep them separate.  

Your timeline should end up looking something like what you see 
in the screen shot below.  Notice I created a second layer, 
because one car is following very close behind another, I wanted 
to make sure the vector art didn’t intersect. Vector art on two 
different layers isn’t in danger of intersecting and possibly 
becoming one continuous piece. 

Don’t try to do exactly what I’m doing above. Figure out your own 
timing because, to be honest, mine is slapped together. I’m just 
making a short semi-random looking loop. If you stare at it long 
enough, it’s easy to spot the loop occurring because it is only 
about 70 frames long. For example, here’s my progress so far...
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I could easily spend 10-15 minutes more and extend this to 200 
frames, but remember this is just one trail of lights. I’ll add at least 
two more and once the others are in, it will be much harder for the 
viewer to focus on the 
loop of one trail. 

Let’s add in that second 
loop now. This time I’ll 
make it less like a light 
saber, so my starting 
vector shape will use a 
bright yellow color and 
the Filter effect will just be a single Glow with that same yellow 
color.  For reference my Filter settings are seen here, but you can 
play around however you want. If you follow the same steps from 
before, you should be able to create a quick second trail. Again, 
I’ve set up this one to show the full trail on the first frame. For the 
most part, this loop is just short animations of this same trail, but 

to get a little fancy I’ve 
added one curved trail 
that occurs inside the 
loop from frame 60 to 70 
(the entire loop is about 
130 frames). This curved 
trail just adds a little eye 
candy to the sequence, 
and emphasizes that big 

Tony is standing in the 
middle of the road.

Illustrating this curve isn’t 
much different than what we 
did before, but we’ll need to 
add a few more vector 
points to the shape to give 
us a smooth bend. I’ll 
demonstrate this in the video below, but on your end, get ready to 
hold down the Option key on the Mac or the Ctrl key on a PC 
when you are click-dragging on the side of a vector shape (using 
the same black arrow Selection tool we used before). If you 
weren’t holding down those keyboard modifiers, the shape would 
just bend without adding an extra vector point. 
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For my final set of lights, I’ll assume this freeway has traffic going both ways and add some red taillights going the opposite way. The 
setup here is no different than before, so I’ll let you test your memory flying solo again. First though, explore some more buttons on the 
timeline. Tap any of the labels in the image below for more details, or you can read the same notes compiled on the next page. 

While you are making subtle changes to these light animations, you should try toggling the Edit Multiple Frames button on. Then select a 
group of some of your existing keyframes using the handle bars noted in the image. Next you can select the art on all those frames at 
once like you normally would by click dragging around it, or choose Edit > Select All (Command / Ctrl + A). You could reposition those 
frames, color them, add Filters, set Blends, or scale/skew/rotate them with the Free Transform Tool (shortcut Q). 
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Free Transform Tool

Handle Bar for Editing 
Multiple Frames

Toggle Layer Visibility

Show Layer as Outline

Edit Multiple Frames



Interactive Gallery Notes

Toggle Layer Visibility - The icon this label points to is what toggles visibility for that layer. The eyeball icon above it toggles visibility for 
all layers, which is often useful for turning everything off, then singling out one layer to turn back on.

Show Layer as Outline - The layers in this screen shot are shown as vector outlines, which is often helpful for editing / animating.

Edit Multiple Frames - This button usually goes unnoticed with new Flash users until they realize they need something exactly like it, and 
begin Googling to search for it. Toggling this on will make two handle bars visible at the top of the timeline. Slide these to choose which 
frames you would like to edit at once. This is often useful for uniformly moving, scaling, skewing, or rotating what you’ve already keyed.

Handle Bar for Editing Multiple Frames - This label 
points to one of the two handle bars used to control 
which frames you want to select when Edit Multiple 
Frames is toggled on. 

Free Transform Tool - Scale, squash, stretch, skew or 
rotate with this Swiss Army knife of tools. Once your 
object is selected and this tool is active, square handles 
around the vector art / symbol will appear. Experiment 
with transforming the object in each of the ways I’ve 
mentioned.   

  
Show ‘N Tell Time... Take a look at my finished freeway 
lights. I don’t think they look “too looped,” and for the 
time I spent animating them, I definitely feel like they 
came out great. Keep in mind too, this is only a small 
portion of the entire piece. 
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For the next leg of this adventure, I’ll teach you how to make a 
news-ticker style billboard. We can hang this brightly-lit, ever-
moving billboard on top of one of the buildings, which will add 
some much needed life to the backdrop. Hopefully it will add just 
enough to be noticed, but not be a distraction. We don’t really 
want someone attentively reading whatever message we write on 
the billboard. So something simple like “Game Tonight!” is good, 
whereas something like “Celebrity Overdose!” is bad.  

The top of the building on the far left of the poster is perfect for us. 
When you begin drawing the lines for the mask you can follow the 
same perspective lines already drawn into the building. As you can 
see from the diagram, I’ll create four blue rectangles on each side 
of the building (so eight total). These will be glowed of course, 
because we can’t have enough glows. Then we will create a mask 
for the “Game Tonight” symbol to move through. The dotted line is 
the path the text will follow, it will travel in from the right, then wrap 
around the building and disappear on the far left.  The mask will 
make the text appear within the lighted billboard area, but ONLY 
within that area. The text in my example image is obviously 
unmasked, because you are seeing it well outside of the blue 
billboard lights. When we work with masks, we’ll toggle back and 

Section 4

Masks and Tweens
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forth between seeing the animation masked and unmasked. 
Seeing both states is helpful in finessing your placement.

Let’s get started. Grab your trusty rectangle tool, set the fill color 
to a bright blue and the stroke to nonexistent, then start pulling 
the corner points around using the same methods we’ve already 
talked about. Once you have four rectangles on one side, select 
each one (hold down the Shift key while clicking to select more 
than one object), then make the art into a Movie Clip by pressing 
F8. It needs to be a Movie Clip so we can add a Glow Filter. Do 
the same thing for the other side as well. You should have two 
symbols now. Whatever you named them is up to you, I went with 
“billboard_left” and “billboard_right”.

If you select both, then add the Glow Filter, you save a little time 
doing the same thing twice. Set the Color to bright blue, the 
Strength to about 170%, the Quality to High, and the Blur X and 
Blur Y can be 5 and 5 on the right one. On the left one, I lowered 
these to 2 and 2.

Finally, for the left side only, unfurl the Color Effect options and 
set the Style pulldown to Tint and make the color full black. Then 
set the Tint percentage to 60%. Tinting also affects any filters 
applied to an object, so if you applied a filter after you had 
already tinted an object, you might by confused when setting the 
color because that tint is already in effect. 
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Now select both sides, and make them into a new Movie Clip 
(again, just hit F8). Feel free to call this symbol something 
appropriate like “Billboard”, because it will contain all of our 
billboard parts: what we’ve already created, the masks, and the 
“Game Tonight” text. This symbol is pretty important, so just in 
case you accidentally deleted it, finding it again in the Library 
under the simple name “Billboard” would be easy. 

How to Create a Mask

On the Billboard symbol’s 
timeline (not on the main 
timeline), create two new 
layers with this button.

As you can see in the 
image above, I’ve renamed the layer containing the existing 
artwork to “back light of billboard”. Layer names really aren’t 

important, but if you want to keep 
things organized, adding one is 
always a good idea. 

Next, right click on the topmost 
empty layer and find the Mask 
option. By changing the layer 
type to a mask, a couple things 
will happen. 

First, the layer icon will look different, as you can see in the image 
below. Second, the layer underneath that one becomes the first 
of many possible layers to be masked. Right now of course 
neither layer has any content. As you can see below there are still 
just blank key frames on both layers, but we are ready to go now. 

Whatever shape we draw 
onto the mask layer (the 
top layer) will be the area 
of the screen that the 
layer below can be seen 
through. Masking is a 

tough concept for beginners, so let’s help some of you out with a 
video from this point on (I’ll also introduce you to the Break Apart 
and Convert Lines to Fills commands)...
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Create a “Classic” Tween

Now that you have the mask setup we can go ahead and add a 
Classic Tween to the timeline. A tween changes a symbol’s 
properties from one keyframed state to another keyframed state 
over a certain amount of time.  For our “Game Tonight” symbol, 
the only thing we will tween is the position, but a tween doesn’t 
necessarily have to involve movement at all. We could use a 
tween to gradually tint a symbol red or change the Glow Filter 
from a Blur X value of 5 to 10. 

I’m starting us off with a Classic Tween because the alternative, a 
Motion Tween, involves the more complex Motion Editor window 
(usually it’s tabbed behind the timeline) and that type of tween is 
overkill for the straight-forward movement we need now. The 
Motion Editor gives us more fine-tuned control, which at times is 
great, but in practice most of the tweens I create in Flash are 
Classic Tweens. I usually just want something to go from one 
place to another and it’s simpler to go with a quick Classic 
Tween.  To give you a little history, in the early days of Flash what 
is currently called a Classic Tween was a Motion Tween. Then 
Adobe improved Motion Tweens, and gave the old way of doing 
things the appropriate name of Classic Tween. We’ll explore the 
relatively new Motion Tweens later with a better example. 

I’m about to give you an unbreakable Flash rule for tweening. You 
ready?... One Symbol, per Layer, per Tween.

If you try to tween two symbols on the same layer, you’ll have 
problems. Like real end-of-the-world type problems, Stay Puff 
Marshmallow Men and such.  So the only thing on that layer 
should be either a Movie Clip or Graphic Clip (make sure there’s 
no scraps of vector art still on there). This will be true for Classic 
Tweens and Motion Tweens. 

In our project, we shouldn’t have to worry about breaking any 
rules because our layer being masked only has the “Game 
Tonight” symbol on it, so let’s go ahead and extend the timeline 
some to get started. You’ll want to insert more frames on every 
layer, otherwise the layers that haven’t gotten more time added 
won’t be visible.

.

It’s easiest to press F5 on every layer at once to Insert Frames, 
so just click-drag down on all three layers at whatever point you 
want to add time up to. Notice in the image above, I’ve scrubbed 
out to frame 300. The frame rate of the movie is 30 frames per 
second, so it’s not hard to figure out that I’ve extended this 
timeline to 10 seconds. In case your division is rusty, the timeline 
will also tell you where you’ve scrubbed to in seconds. The 
orange area circled above is where to find the current time.
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Next, select the last frame on the layer with the text symbol, and press F6 to 
add a keyframe. You now have two keyframes on this layer: on frames 1 and 
300. We’re ready for the Classic Tween.

Select any frame on the layer between those two keyframes and right-click, 
then find Create Classic Tween, like so...

Afterwards, the part of your layer between those keyframes will turn blue with 
a line through it like you see in the image below...

Now all you need to do is position the symbol where you want it on frame 1 
and 300. Be sure the layer being masked is unlocked, otherwise you can’t 
select the symbol to move it. Diagrammed above, you can see roughly where 
I’ve moved the “Game Tonight” text on each frame. 
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We’re at the halfway point so go ahead and test the movie 
whenever you like.  All we need to do now is make the text wrap 
around the left side. Or better said, create the illusion of the text 
wrapping around the side, because we won’t actually do anything 
different with what is already in place. Instead we will create a 
second mask, with a second symbol and repeat the same steps 
we’ve already gone through. This second “Game Tonight” symbol 
will begin it’s animation right when the “G” from the first symbol 
starts disappearing out of the right mask. Go ahead get this setup 
on your end. 

In my project, frame 83 is when I’m starting to bring in the second 
symbol. By now you’ve probably figured out you can slide 
keyframes around, but if not, try it out. If you slide the keyframe at 
frame 1 to somewhere else, it will leave a blank keyframe at frame 
1. So visually nothing will appear at that point, which is what we 
want because we don’t want to see the “Game Tonight” text on 
the left side of the billboard immediately anyway. 

Instead of sliding the keyframe at frame 1, you could start with a 
blank layer, then insert a blank keyframe by hitting F7 at frame 83 
(or so), which will give you a place to paste in artwork that visually 
won’t appear prior to that point. 

Notice in the screenshot to the left, my second “Game Tonight” 
symbol has been tinted a shade of grey. I just thought this looked 
a little better in the finished version and gave it a more 
dimensional feel. It’s obviously skewed a lot more sharply than 
the first symbol, but it’s still the same exact symbol that’s on the 
other masked layer.

Now the tricky part is getting the second keyframe correct. Go 
ahead and insert in more time to the timeline by hitting F5, again 
on all layers, and extend it to around 400 frames. You might not 
need all 400, but it’s a nice round number.
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Go ahead and add a keyframe at 
frame 350, and move the symbol to 
it’s final position, which should look 
similar to what you see in the 
screenshot to the right. 

Next you’ll need to experiment with 
the timing some by sliding that 
keyframe back and forth. You’ll want 
to scrub the timeline and make sure that when each letter leaves 
the first mask, it then starts appearing within the second mask, 
give or take a frame. It doesn’t need to be perfect, but it should 
come close to accurate. 

You can see my finished version below...

One last thing to note about Classic Tweens: each keyframe is 
marking the position, rotation, scaling, skew, color effect, 
filters, etc all at once. In our project, even though we only 
changed the position, those other properties have been keyed on 
those frames. The advantage of the newer Motion Tweens is 
those properties can be shifted independently of one single 
keyframe. So even though the Classic Tween is easy, it’s less 
flexible if we want to change many different properties during that 
time span.
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Shape tweens are similar to motion tweens, but instead of 
working with a symbol, we’re animating the shape of the vector 
artwork itself. This can be very tricky, and quite often you’ll get 
some unexpected results. In defense of the software, what we’re 
asking Flash to do is difficult. The more similar the two shapes 
are, the more chance of a smooth, seamless transition. So for 
example, a vector object with 4 points (like a square) will usually 
transform as expected into another shape with 4 points. For 
example, in the image below, the shape on the far left was my art 
at frame 1, the shape on the far right was the second keyframe at 
frame 4, and the two shapes in the middle were how Flash made 
the object look at frames 2 and 3. This is exactly what you would 
expect from a simple shape tween, and regardless if I was 
tweening over 4 frames or 400, I would get a seamless transition. 
The timespan of the tween doesn’t complicate things, what 

matters is the two shapes we are going between. So let’s look at 
this again, but now with the same first shape tweening into one 
with 8 vector points (I’ve made the vector points visible in the 
image below just so you can see where they are).

 
The two middle images might look a bit strange, but what we’re 
doing is a bit strange too. Those new points have to spring forth 
to life from somewhere, so again, this is an expected result from 
a shape tween, but perhaps a cautionary tale. If you start with a 
shape with a certain number of vector points, then try to tween to 
another shape with more or less points, Flash has to get creative 
about where to add or delete some of them. 

Section 5

Smoky Shape Tweens
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Take a look at what happened in the case below. I subtracted just 
one point from the first shape to make the end shape, I didn’t 
move any other points around, but the tween created this mess in 
between.

I’ll take the blame though, because I know better. Shape tweens 
try their hardest. It’s on us, the user, to make life easy on them. 

Ready to try this out? Just draw a square for now, keyframe it 
twice, then right-click on the timeline between the two keyframes 
and select Create Shape Tween. In the example below, I’ve 
already created one shape tween on this layer and I’m right-
clicking to create a second. Note that the layer turns a nice shade 
of green instead of blue like the Classic Tweens we saw last 
section. 

After you’ve played around a bit, let’s do this for real with some 
smoke. I think smoke is very easy to draw in Flash, a light bevel 
and some blurring goes a long way to make a wispy grey shape 
look like smoke. Animating the smoke is a bit tougher, and like 
many things, I’ve found a “less is more” approach is much better. 
Let’s make one subtle symbol of smoke that’s fading in and out, 
and changing shape just slightly. Then later, we can add a smoke 
ring, or puff that occasionally floats outward from the cigar.

By now, you all know how to draw a little in Flash, by adding 
vector points, bending the shape, etc, so I won’t spend much 
time on that in the next video. Instead I want to focus on the 
Gradient Transform Tool (shortcut F), so we can make our 
vector artwork less transparent at the top compared to the 
bottom where the smoke is emitted from the cigar.
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In the diagram to the left, you can see I’ve got four 
frames, but only three of them are unique. The last 
frame is a copy of the first frame to make this a 
seamless loop, and the two middle frames are just 
slight variations of the first. I reshaped the original 
smoke, but I didn’t redraw it entirely, so Flash has an 
easy time shape tweening this. If possible, you want to 
leave as many vector points unchanged as you can, so 
hopefully Flash doesn’t shift those around during the 
tween. In this case, my vector points in the top left and 
bottom right (by the cigar) weren’t moved at all on any 
of the frame changes.

My next step will be to lengthen the overall time of this 
loop. In the diagram you can see the animation only 
goes to frame 56, but that was just so I could fit all four 
keyframes into the example image. That loop is too 
fast, and if you were to test publish right now, I think 
you would agree. I’m going to slide the last keyframe 
to frame 300, the third keyframe to frame 200, and the 
second keyframe to 100. If you don’t want to slide the 
keyframes around, you can always just hit F5 between 
keys. In case you haven’t noticed yet, you can select 
multiple frames on the timeline before hitting F5 and 
this will insert increments of the amount you have 
selected. So to insert 10 frames, you can select 10 
frames and push that many out. 
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We should have a decent looking, yet subtle, loop. Let’s check in 
on it above.

My only critique here is that the smoke is too constant. We can 
fade this in and out in two ways. The first way would be to revisit 
our shape tweens and change the transparency on the swatches 
for the gradients. That would work, but the same keyframes 
would always be receiving the same transparency, so it’s not very 
random, and if you stared at the loop long enough, you would 
notice it. The second method would be to tween the Alpha 
property on the entire Movie Clip which contains our shape 
tween. We’ll make that into it’s own loop with a time frame of 200 
frames. Since the shape tween is 300 frames long, the two loops 

are offset from each other, and this will give us more variations of 
how the smoke appears.

Does that make sense? No!? That’s okay. Movie Clips looping 
inside other Movie Clips is a tough concept at first, but this can 
be the foundation of many very clever things you do in Flash. 

So let’s set this up. 
Right now my Movie 
Clip symbol 
containing the shape 
tween is called 
smoke_shape. I’m 
going to select that 
symbol from the main 
timeline, and hit F8 to 
convert it to a new 
symbol. Again, this 

will be a Movie Clip, and I’ll name it smoke_fading.

If I were to publish the movie now, nothing would be different. 
Even though my smoke_fading symbol only contains 1 frame 
(with the smoke_shape symbol on that frame), that doesn’t effect 
the playback of those 300 frames of shape tweening. File that in 
the “Strange But True” folder of your brain, but trust me, it’s really 
useful for animation. 
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Moving on, let’s extend the timeline of the smoke_fading symbol 
to 200 frames, with a keyframe on 100 and 200 and Classic 
Tweens between all the frames.  The keyframe on 100 is the only 
one we want to alter, because again, we want a seamless loop so 
frame 1 and 200 need to be identical.  

You can see the changes 
I’ve made on frame 100 in 
this example image.  
The Alpha is set to 20%. 
The Blur filter has a  
Blur X value of 28 and 
Blur Y value of 29.  
 
On frames 1 and 200 the 
Blur Y goes back to 5, so 
this is a pretty significant 
change. Combined with 
the transparency change, 
this should make the smoke appear to die off as it changes 
shape.  Feel free to experiment with other properties as well. 
Worst case, if you do something you think can’t be fixed by 
hitting the Undo button a bunch of times, you can always right-
click on frame 100 and find Clear Keyframe, then copy and 
paste frame 1 to frame 100 to start over. 

Note that Clear Keyframe is slightly different than the Clear 
Frames option also found by right-clicking. Clear Frames would 
bump the keyframe forward, and leave a blank keyframe in it’s 
place. Clear Keyframe is generally what you want because it 
completely removes the keyframe, without doing anything else on 
the timeline. In this case, if you removed the keyframe at frame 
100, the tween from frame 1 onward is still in place, so that would 
extend to frame 200. That’s harmless of course, especially 
considering frame 1 and 200 are identical anyway. 

I think we’re done with that layer of smoke. If it’s not already on 
one of the two layers called “cigar smoke”, go ahead and paste it 
onto the lower of those two. On the topmost layer, I want you to 

add a ring of smoke that 
occasionally appears, 
maybe once every 500 
frames. In the example 
image here, you can get 
an idea of where I’m 
headed with this: a basic 
grey donut shape (with 
the filter effects on 
bottom) will fade in and 
out while traveling right to 
left. 

45



Let’s make this part of the project less of a hand-holding session 
and have you try it alone. Here’s some tips: 

• To create the donut shape, draw one circle with a light grey 
color. Then within that circle, draw another circle with any other 
color. Then simply delete the interior circle. Call yourself Krispy 
Kreme because you’ve made your first donut. 

• Make the donut shape into a symbol by hitting F8, add your 
Filter effects, then hit F8 again to make another symbol which 
will contain the animation of the donut moving / fading in and 
out. 

• For the animation, you only need 3 keyframes and I would 
recommend an overall time length of about 200 frames. Since 
you’re probably still using the Classic Tweens, as that’s all I’ve 
taught so far, I would recommend working with 2 keyframes first 
to do the motion and scaling, then add a keyframe in the middle 
of those two to change the alpha. Think about the reasoning 
here: you want the ring to move in equal increments throughout 
the entire duration for a smooth flow. By keying the beginning 
and end first, and then inserting a middle point, you’re keeping 
those equal increments. Whereas, if you moved the ring some, 
then keyed it, then moved it again and keyed it, the first and 
second tweens might not move the ring the same distance. 
That could make it seem like a car driving at one speed, then 
suddenly accelerating forward at another speed. 

All finished? You can see where my project is at below. Hopefully 
yours is looking even better...  

 
If you want to go the extra mile, 
draw a simple yellow circle, give 
it a nice glow and fade that in 
and out within a Movie Clip 
overtop the end of the cigar.  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Like our billboard, we’re going to keep adding some life, or 
“noise” to the city. Some indications that, even though it’s night, 
the city is awake. We can do this with windows turning on or off, 
subtle movements in a window, police lights, and a helicopter 
flying past. Next section, we’ll look at actual noise you can hear.

Let’s tackle the police lights first. All we need to do here is run some 
flashing blue and red illuminations up the walls of the buildings on the 
far right.

Create a Movie Clip called police_lights, and add to that a mask in 
the shape of the background buildings (like the one in the far left 
image). The motion tween you see in that picture is moving a symbol 
named police_lights_swapping_places which contains a red circle 
and blue circle. 

Both circle symbols have a Blur 
filter applied with a Blur X value 
of 33, a Blur Y value of 99, and 
the Quality is set to High. 

As you can see from the images 
on the right, the animation just 
swaps the positions of the red 
and blue symbols and loops 
them back to their original 
places. That’s it!

Section 6

City Noise
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Take a look at my version above. If it looks slightly different than 
yours, I did a few things to fine tune it...

I added a Blur to the entire 
police_lights symbol. This 
made it so the mask had less 
of a hard edge to it.  
 
Next I set the Ease 
property to 100, or 
100% ease out. You 
can find this option in 
the Tweening panel of 
the Properties window while at least one frame of the tween is 
selected. This option is available for shape tweens as well. 

The concept of “easing” in animation takes a little bit of 
explanation. It’s exactly what it sounds like, but at times, I even 
think, “wait, did I want to ease this in our out?”.  

Suppose your tween of a ball was eased out from one keyframe 
to the next keyframe, this would mean the ball would slow down 
before hitting the final position, and appear to start faster. In other 
words, larger increments of movement would start the animation.

If your tween of a ball was eased in instead, the ball would start 
slower, and appear to end more abruptly. In other words, smaller 
increments of movement would start the animation. 

So in your Tweening panel, -100 is fully eased in, and 100 is fully 
eased out. 
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The last thing I did to tweak the police lights was within the 
police_lights_swapping_places symbol. If your version was 
like mine, we made frame 1 and 7 the exact same keyframes, 
which is what we’ve been doing with our looping Movie Clips so 
far, making two identical. The problem here is that this animation 
is very short, and a quick loop with two of the same frames can 
look choppy, almost like the movement stops for a split second. 
Wait, I shouldn’t say “almost” because thats exactly what 
happens. Below is a quick fix...

That’s all it takes. Essentially you created the keyframes on 7 to 
be “throw-aways”, using them to make another set of keys and 
just tossing them out afterwards. You’ll do this a lot with loops.   

A Helicopter for Ants

Our helicopter isn’t going to be too 
mind-blowing here. Nor does it need 
to be. You can see what I have in mind 
in the example image to the right. It’s 
just a tiny black circle with a cone of 
light underneath. The light has a 
gradient fill color of a semi-transparent 
white to a more transparent white. 

I feel comfortable leaving this animation up to you, there’s nothing 
new to teach about moving a Movie Clip around, but one thing I can 
introduce is some Actionscript 3. You’re thinking, “What!? I’m not 
gonna code jack!”. Well, here’s the thing, testy reader. It’s worth 
knowing a little Actionscript for animation. Currently, all of our Movie 
Clips have just looped back to the beginning after hitting the end of 
the timeline. This time around let’s add a Stop Action.

Create a new layer in whatever symbol contains your tween for the 
helicopter, and call this layer something like “Actionscript”. Then 
create a blank keyframe (F7), after the last frame of the tween.
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Here’s what we’re starting with: 
Frame 1 and 7 are the same.

Select the two frames on 6 and 
hit F6 to add keyframes.

Then just select the frames on 7,  
right-click and go to Clear Keyframes



With that frame selected, open your Actions window. Do this by 
hitting Option + F9 on a Mac or just F9 on Windows, or the slow 
way from the top menu by going to Window > Actions. Again, be 
sure that blank keyframe is selected. You’re writing code on that 
particular frame which also means, you could slide the code 
around later to adjust 
exactly when the stop 
action occurs.

In the Actions Window, 
simply write...

stop( ); 

That wasn’t so bad now was it? The keyframe should have a 
small “a” on it.  Now if you were to publish, you would see the 
helicopter fly past once and it would be gone for good. Notice in 
the image above, I even added a blank keyframe after the tween, 
so the symbol containing the helicopter art is completely gone.

While we’re on the topic, you could also experiment with writing...  
 
gotoAndStop( 1 ); 
 
Which would do exactly what it says above, make the timeline go 
to frame 1 and stop. Or you could write the play variation of that...

gotoAndPlay ( 1 );

In both of those examples, you could write any existing frame on 
the timeline other than 1.  If you really wanted to have some fun, 
you could send the timeline to a random frame, like so...

gotoAndPlay(  Math.round(Math.random( ) * 9 ) + 1  );

In that example, the timeline would be sent to a random number 
between 1 and 10. Let’s break it down. This snippet below...

Math.round(Math.random( ) * 9 )

...gives us a random sampling of 0 to 9. Problem is, there’s no 0 
frame on the timeline. So if you try to go to that frame, the 
Actionscript compiler just does the safest thing possible, it 
ignores that command. Which is why we need to add 1 to that 
amount so we never get a result of 0.

Pretty cool, huh? Okay, maybe it’s not “cool” in the Fonzie sense 
of the word, but jumping to random frames can be quite useful. 
Actually, broaden the scope of your thinking, and imagine 
jumping to random sections instead of just random frames. So 
one Movie Clip might contain ten different animations, perhaps 
slight variations of explosions. Instead of dealing with entirely 
different symbols, you could just have one symbol that randomly 
does different things. Or multiple instances of that same symbol, 
all playing random animations. We’ll discuss exactly that in a later 
chapter. 
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A Room With a View

Right now it looks like no one 
is home in any of our buildings, 
so let’s turn the lights on in a 
few of them. The danger here 
is making the animation too 
“blinky”, so I would suggest 
just doing one light turning on 
or off, and stopping it from 
looping. I’ll let you decide the 
color and Glow filter level on 
your own. Although, I would 
suggest a higher Blur Y than 
Blur X value (like the image on 
the right). I think this looked 
better in my version. 

Let’s have a little more fun 
with the next set of windows. 
I’ve created a Movie Clip with 
two layers. One layer has four 
of the windows, the other 
layer has a window with a half 
circle subtracted from it. We’ll 
shape tween that circle 
moving back and forth, which 

should look like someone either pacing or vacuuming in front of a 
window. 

Before you draw an actual circle over top a square, you’ll 
probably have more success with the shape tween if you start 
with a rectangle instead. Below you can follow my steps...
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Blur X: 10
Blur Y: 10

Blur X: 5
Blur Y: 30

1st Keyframe 2nd Keyframe

•  Keyframe the yellow square twice

• Draw a black square on both frames, 
extending it slightly outside of the 
bottom of the yellow square.

• Bend each side of the black square, 
just be sure you don’t bend it outside 
of the yellow square. 

• Delete the black squares.



Now you can shape tween between the first and second keyframe (hopefully with success). Next, select the 
first frame, right-click and select Copy Frames. Then extend the timeline past the second keyframe, and 
right-click on any frame and select Paste Frames. So you have 3 keyframes total. My animation is about 200 
frames long. 

Once you’re done, you should add a Glow filter to the entire symbol. The main reason I used a shape tween 
and subtracted that vector art, was so the window glow would account for that subtraction and create the 
more realistic effect that the arrow is pointing to in the image on the right. If we had tweened a symbol of a 
little guy inside the window, the glow wouldn’t look like that. Let’s take a look at it in motion... 
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Mull this thought over for a moment (stroke that goatee if you’re 
rockin’ one)... Would you rather lose your hearing or lose your 
eyesight? It’s a morbid choice, but bear with me. There’s a lot of 
advantages to seeing your way around. You can drive a car, see 
your kids, read, and avoid the simplest hazards in life, like walls. 
It’s hard to argue you would maintain more of your regular routine 
if you suddenly lost your hearing over your eyesight. 

Except would you rather hear the TV or watch the TV? From the 
safety of your couch (where you won’t bump into anything 
covering your eyes), find an episode of The Simpsons, or 
something with more comedy than action. Close your eyes for a 
minute and experience the show. Now open your eyes and mute 
the TV for a minute (and no, you can’t use the closed captioning). 
Which sense did you feel entertained you more? 

I feel like the sound is usually just as important, if not more. I’ve 
been a test case for this little theory over the last decade of 
being my own worst boss, i.e. working with a laptop in the TV 
room or marathoning DVD seasons on my desktop’s second 
monitor. In my defense though, I really don’t look away from my 
work when I’m listening to the TV.

So what do you think, is your entertainment center an equalizer 
of the big two senses? Is what you hear just as important as 
what you see? If you agree, this could be a big factor in our 
quest to fake a great animation. We have to do some sound 
work, and yet again, rely on our modest resources.

Now, I hope my emphasis on sound isn’t taken the wrong way by 
my deaf readers, because of all my readers, you can’t be faulted 
for taking sound for granted, which is what this lengthy intro is 
addressing. For us amateur animators, audio is too often an 
after-thought in production. Who can resist animating a butt-
kicking character instead of searching for sound files?

Inevitably the worst work we do is the last day on the job, and I’ll 
confess that for this chapter’s project, I did the sound work last 
because I got carried away with the animation side of it. For a 
short animation (and especially this “motion poster” concept), it’s 
easy to do a little of this, a little of that, and then suddenly, poof, 
the piece is almost done. Once I started working with the audio 
though, I got inspired to add more to the animation (you’ll see 
what in Section 9), so at least I left myself open to a last minute 
addition. That won’t always be easy though, and darnit, I know 

Section 7

Adding & Altering Sounds
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better. I should have based my animation around the sound to 
begin with, not troll for usable clips after I was mostly done.  

A soundtrack to animate off of structures your work. In the 
“real world” of production, the sound is done very early on. 
Generally animators don’t have a free pass to do “like, whatever, 
dude”, and then hand their work off to an audio engineer to add 
the sound after the fact. You want to be able to close your eyes, 
and listen to your animation before doing a lick of actual 
animating. The timing of things that work and don’t work can 
often be figured out with just the audio. 

So what’s a guy or gal to do if they don’t know an audio engineer 
that also owes them a big favor? You gotta hit the internet for 
sound.  

Sound Resources

Two great collections to look for are appropriately named “Flash 
eFX” and “Flash eFX 2”. They are both available through Sound-
Ideas.com. For what you get at that price (currently under $70), 
they are well worth it. As you’ll find out, the more you’re willing to 
spend for a good audio library, the more you get. Some 
collections have tens of thousands of sounds to them. 

For those of you less interested in being featured on Hoarders: 
My Audio Addiction, you can also buy sound in the same way you 
usually buy stock art, just get what you need. In the past, I’ve 
purchased from AudioMicro.com and AudioSparx.com

 
Put Some Audio in Flash Already!

Okay, okay. Common file types you can import to Flash 
are .wav, .aif or .mp3. I’ll include a file called 
background_audio.aif in the zip file of resources for Chapter 2 of 
this book. You can go to the File menu and choose either Import 
to Library or Import to Stage. For now, just go with the Library 
option. Once imported, you can now create a blank keyframe (or 
new layer), select the frame and go to the Properties window and 
select the audio clip in the Sound panel, like so...
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Initially, you might not see much difference in that frame you 
imported the sound to, but if your timeline was extended beyond 
just a single frame, you would eventually see the wave form of the 
audio. For our current project, we don’t want to do this (or need 
to) because our entire animation will happily stay at frame 1. So 
how will we hear the audio?  

Stream Audio vs. Event Audio

Flash has two very important 
Sync settings in the Sound 
panel: Event and Stream. 
With the Event setting the 
entire audio clip will play 
when the timeline plays (or 
stops on) the keyframe 
marking the start of that 

sound. With the Stream option, the layer with the audio file must 
be playing to hear whatever part of the sound you can see in 
wave form on the timeline. So the frames need to be inserted like 
you see above.

Another big difference between the two playback options is in the 
authoring environment. With the file set to Stream we can scrub 
the timeline back and forth and hear whatever snippet of the 
audio is occurring at that frame. With the Event option, we can’t 
do that at all. Regardless of what you see of the audio wave on 
the timeline, you must trigger the first frame of the sound to hear 
the entire clip. Which can be annoying if you accidentally start a 
lengthy clip playing. It’s all or nothing basically. 

Some of you might be wondering, “Why is there an Event option 
at all?”. That’s a fair question because it seems like for animation 
we should always be syncing our animated frames to what we 
can see and more importantly, hear scrubbing the timeline. That’s 
true. Remember though, Flash is that jack-of-all trades program 
we talked about earlier. Triggering the entire clip based on an 
“event” makes perfect sense for interactive content developers. 
For example, the user clicks a button causing the timeline to jump 
to a specific frame. The timeline stops to show a picture of an 
elephant, but audio-wise, the viewer hears a three second 
elephant roar. The timeline isn’t running, but sound is playing. 

As an animator you’ll probably be using the Stream setting most 
often, and especially for things like lip syncing where it becomes 
crucial you have specific mouth poses at the right time. The 
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Event option is dangerous to rely on for syncing because it can 
actually fall out of time with what is currently being seen on stage.  
If your published Flash Player file (the .swf) is struggling to play 
back what you’ve created, the Stream setting helps make sure 
that what you see and hear sync up (even if that means frames 
are skipped to keep time with the audio). This should be less of 
an issue with exporting a Quicktime movie, but I would still favor 
the Stream setting for accuracy anyway.  

In our current project we need to use the Event setting since 
everything is occurring on one frame of the main timeline, plus the 
background_audio.aif file won’t be synced to anything anyway. 
It’s just a mixed track of car honks overtop some ambient 
whirring noise that could be cars on a freeway (or just wind), and 
a little rhythm. It’s nothing fancy and it somewhat contradicts the 
intro of this section emphasizing the importance of great audio. 
Sorry, I didn’t hire anyone to make something spectacular for this 
example project, but this is just a little foundation sound. We’ll 
add more sound effects later.

You can choose to Repeat or 
Loop the sound. Loop is 
endless, Repeat gives you the 
option to set a number of times 
to replay. Setting this to 1 (or 0) 
just plays the audio once. Any 

number higher than 1, plays the sound that many times total. The 
phrasing in the Properties panel is a little misleading. You might 
read Repeat x 1 and think that means repeat the sound once, but 
it just means it will play it once. 

The Effect pulldown menu gives 
you some preset options to change 
the audio.

• Left Channel - plays only the left 
channel.

• Right Channel - plays only the 
right channel.

• Fade to right - this effect spans the entire length of the clip, 
beginning with the right channel off and the left channel on, 
then fading out the left while fading up the right. 

• Fade to left - this effect spans the entire length of the clip, 
beginning with the left channel off and the right channel on, 
then fading out the right while fading up the left. 

• Fade in - fades in the beginning quarter of the track.

• Fade out - fades out the last quarter of the track.

• Custom - gives you custom control of each channel through 
the Edit Envelope window (shown on the next page)
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The Edit Envelope Window 

After choosing any of the Effect pulldown options, you can click 
the small pencil icon next to 
your choice and enter the 
same Edit Envelope 
window which would 
automatically pop up if you 
went with the Custom 
option. 

This option has been in 
Flash for as long as I can 
remember, but I have a 
feeling many users don’t 
stumble onto it for a while. 
The window gives you a 
close up view of the audio 
wave, which you can zoom 
in or out on to get a better 
view.  

The Left channel is depicted 
as the top wave, the Right is 
the bottom wave. In the 
screen grabs on the left, you 
can see control handles (the 
white squares) which are 

markers on the volume level line. If the handle is completely 
lowered, the sound is muted for that particular channel. If the 
handle is on top, the volume is at 100%. You have a possible 
range from muted to full volume by adding handles in between 
the top and bottom of the channel. 

To add a new handle, simply click anywhere on the volume line 
and move it up or down. To 
remove a handle, just drag it 
sharply outside of the 
channel.

If you wanted to lower the 
volume of your entire clip, 
(without bothering with a 
fade on either channel), you 
would first remove any 
existing handles, then add 
one handle on each channel 
and place it somewhere 
between the top and 
bottom. You should have a straight volume line across the 
channel, like you see in the image above.  
That looks like a volume change of about 25% the full volume. If 
we lowered the volume with Actionscript we could set an exact 
volume change of 25% but this is a close enough approximation 
for me. If it plays back at the right volume for your ears, it’s fine. 
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The last cool thing you can do with the Edit Envelope window is 
a little “too cool” to explain properly with text, so I’ll let you watch 
a video to see this better. In short though, you can trim the clip to 
fine tune how it plays or repeats. Take a look...

 
Another way to trim a clip (if it is set to Stream) would be to add a 
blank keyframe on the timeline where you wanted it to stop. 

This option is not nearly as exact as trimming it in Edit Envelope 
window, and you can’t offset the start time either.

Sound Compression Settings

Compressing your audio isn’t necessary if you’ll be exporting to a 
Quicktime movie. You can use as many sounds, channels, and 
layers as you want without worry. The sounds are combined into 
a single sound track on export. If your end-goal is for the .swf file 
to be viewed (and loaded) on a website, then it’s a good idea to 
keep reading. 

From the Library, double click on the sound file you’ve imported, 
and you’ll see the screen below. 

Pull down the Compression options and let’s explore each of 
these.
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• Default - Exports the sound according to the global values in 
your Publish Settings. Go to File > Publish Settings and  
choose a compression for all 
Audio event or Audio stream 
sounds using this option.

• ADPCM - Sets compression for 8-bit or 16-bit sound data. The 
suggested ADPCM usage is for short Event sounds such as 
button clicks.

• MP3 - Lets you export sounds with mp3 compression. The 
suggested use for mp3 is when you are exporting longer 
sounds such as music tracks.

• Raw - Doesn’t compress the sound at all. You’ll playback the 
raw audio file. 

• Speech - Exports sounds using a compression that is better 
adapted to speech.

 
 
We’ll import more sound later, but we can take a break on this 
topic for now. If you want to play around with some extra sound 
files that come included with your copy of Adobe Flash, go to 
Window > Common Libraries > Sounds. They have enough 
sounds to give you an idea of how useful a real collection of 
royalty free clips could be. 
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Let’s knock out the blink first since 
this won’t take long. Double-click 
into the parent symbol holding all 
of Tony’s other symbols. Then 
double-click the head, which is 
named “head_symbol”. You don’t 
have to lob it off the body like in 
this screenshot, I’m just trying to 
emphasize the head parts are 
completely separate. Once inside of the head_symbol, hit F5 to 
insert enough frames to extend the timeline out 8 to 10 seconds. 
Like all Movie Clips this one will loop, so you want to give 
yourself time between blinks so it isn’t too repetitive. 

Now you can add the blink animation one of two ways. You could 
add a new layer above the current symbols, and draw overtop of 
the eyes, by reshaping a circle or square. Then a few frames later, 
hit F7 to add a blank keyframe on that layer, which will end the 
blink. If you go this route, you don’t have to keyframe the layer 
holding all of the head symbols. 

I would take another approach which doesn’t involve drawing on 
a second layer. Instead, add 2 keyframes on the layer with all the 
symbols. Make them 5 or 6 frames apart. In reality a blink would 

only occur over a couple 
frames, but I think cartoon 
blinks look strange if they 

are too fast. You can always slide some frames around and see 
what speed you prefer. 

Now on the first of the two frames you just added, select the 
symbol around the left eye, named 
“eye_lid_area1”. Once selected, 
right-click and choose Duplicate 
Symbol. I named this new symbol 
“eye_lid_area1_blink”. Go ahead 
and do this for the right eye 
symbol as well. Then within each 
symbol, you can extend the lid 
(this art is on it’s own layer), and 
delete the middle black line across 
the eye. Hit Test Movie and check 
out your finished blink. 

Section 8

Title Animation (and a Blink)
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The Title Sequence

Animated titles deserve their own chapter in this series and they’ll 
get one eventually. In your life as an animator, you’ll have plenty 
of reasons to make letters move across the screen, maybe for a 
short cartoon or for the opening splash screen of an app. If you 
ever need some inspiration, just turn on the TV and you’ll see a 
title animation in a commercial, intro to a show, a film’s opening 
credits, and many production studios have short sequences after 
a show (us Lost fans probably all remember seeing the Bad 
Robot tag while waiting for the preview of next week’s episode).   
You can also visit the website ArtofTheTitle.com which has a huge 
compilation of title sequences from movies, all free to watch. You 
don’t need to search out much inspiration for this title though, 
because that’s what I’m here for.  Let’s get started with, what I 
consider, a great setup for a title animation, which can easily be 
changed to try a few different things with. So by the end of this 
section, you might have a very different looking title than me. 

Using the Text tool, go to the Properties window and under 
Family choose an Impact font if you have it. It’s a pretty common 
font but if you don’t have it installed, any font with big bold letters 
will do. Type out “Tony’s Game”, and that’s what we’ll call this 
fake movie. The word “Game” in a title always seems cool to me. 
“Game of Thrones”, “Ripley’s Game”, “The Game.” All very cool. 

You might notice I’m using Classic Text instead of TLF Text for 
this, but it doesn’t really matter which you choose, because next 
we’re going to hit Modify > Break Apart twice, and just make 
each letter vector art. Now select every letter, one at a time, and 
hit F8, converting each one to their own Movie Clip. My symbols 
are all named after their corresponding letter, for example, “T”, 
“o”, “n”, and so on. 
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You might be curious why I’m breaking the text all the way 
down to vectors. If I wanted to alter the vectors in some way, 
then it makes sense for that reason, but I’m not. I want to 
destroy the font for safety’s sake. I’m pretty sure I’ll always 
have a copy of the Impact font installed on my computer, but 
let’s assume I was using something more unconventional and 
didn’t break apart the text. Skip to a few years later, and for 
some reason that rare font isn’t still installed on my machine. I 
open up this Flash file and suddenly the title sequence no 
longer has a font associated with it. If that was the case, Flash 
would pop up a warning, and give me a chance to use a 
different font, but most likely I would only want the original 
version back. So I think it’s worth future-proofing this file 
against having to do that. You could argue though it’s worth 
keeping the font editable in case your boss decides “Tony’s 
Game” is a terrible title, so proceed with caution before doing 
the double Break Apart. How sure are you that text is set in 
stone is really what it comes down to? If you’re animating your 
own name, that’s something that probably won’t change.

Next, select every letter then hit F8 and create a new Movie Clip to hold our entire title sequence. I named this symbol “title_sequence”. 
Until we are finished animating the title, the rest of our work will occur within this symbol, so any screenshots will be of that timeline.

In the title_sequence symbol, select every letter again, then right-click and choose Distribute to Layers. This command is a huge time-
saver, so make a mental note that you have this option when you need it. Every object selected will get put on a new layer of it’s own 
which is convenient considering Flash’s rule to tweening: one symbol, per layer, per tween. Each layer also gets named after the symbol 
on it (note the layer’s names in the screenshot above).
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In the next few steps, each letter will be tweened into 
it’s final position, which should be where the letters 
are currently at onstage. So we’re going to work 
backwards essentially.

For the next four steps, you can follow along with the 
screenshots on the right. 

1.  First, select every layer on the second frame.

2.  Then hit F6 to keyframe them. 

3.  Drag those new keyframes outwards.

4.  Finally, right click and add a Classic Tween. In 
the Properties panel you can set the Ease to 100 
(full ease out).

Now the keys on frame 1 will be the ones we move, 
scale, blur, or transform in some other way. I have my 
own idea in mind as to how I want our letters to move 
into position, but you can veer off from that at this 
point. The important thing here is the setup: we can 
uniformly change all of the frames on 1, then slide 
around the tweens afterwards to offset when each 
letter comes in. On the right, I’ve diagrammed some 
possible transformations to consider.
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Possible Transformations on Frame 1

Moved Down and Blurred on the Y Axis

Uniformly Scaled Up and Blurred

Scaled Up, Overlapped 
& Offstage

Step 1

Step 2

Step 4

Step 3



Next, let’s play around with offsetting each tween. Again, this can 
be a “choose your own adventure” type exercise, but my plan is 
to bring in each letter in order, the “T” first, ending with the “E”. 
The easiest way to do this is by selecting multiple layers and 
bumping each tween forward by hitting F5. You can watch the 
short video below to see this is in action....

Now that you’ve got something fun occurring with those letters, 
you might decide the best place to run this animation isn’t as 
soon as the entire movie plays. As it is now, the sequence starts 
at frame 1 of the Movie Clip which would also run at frame 1 of 
the main movie. So let’s slide everything down a few seconds. 
Attentive readers might realize the problem we’re about to run 
into. The first frame of the title_sequence symbol will be blank 
and once we’re back on the main timeline, we won’t have an easy 

way to select that symbol. It is possible to find it again by drag-
selecting where you think the symbol is, and you might pick up a 
tiny point, but let’s do something better. 

 
 
I’m going to create a layer and name it “Dummy Title”. On the first 
frame of that layer, I’ll paste in the entire title and move it offstage, 
then add a blank keyframe after that. It doesn’t really matter what 
appears on that frame since it will never be seen on export, but if 
you put the title there, you’ll easily identify that as your title 
sequence symbol.

At any point if you feel like you’re tired of seeing this sequence 
loop when you publish, you can add a Stop action after your 
tweens. I’m going to hold off though, since I usually like to 
preview the animation looping until I’m completely finished. 
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Mask It All! 

Let’s keep the fun going and mask all the layers we 
have so far (except for the Dummy Title layer). I 
have an audio track we can import and sync the 
animation to by keyframing the mask itself. The 
track begins with a “whoosh” sound, which can 
occur while the letters move in, and it ends with 
three short bangs. 

In the zip file of resources for Chapter 2, find the file named 
whoosh_and_bangs.aif. Once you import that, create a new layer, 
add a blank keyframe toward the beginning of your sequence of 
tweens, then set this sound file to Stream from that point. You can 
see where the bangs occur on the timeline because they are pretty 
obvious spikes in the audio wave (I’ve also pointed them out in the 

top-right image).

One thing to try with the mask is 
removing what’s visible from the 
current title in a streaking 
pattern. For example, the top 
image on the left, isn’t adding 
black over top of the “Game” 
text, it is simply masking what’s 
visible of the title. You can see 
the vectors of the mask in the 
bottom left image. 

Obviously I’ve tinted the “Game” text red in those images to 
give it a little edgier feel than plain white. What you could try 
is starting them white than tweening the tint to red.  

Masking and tinting shouldn’t be a problem by now so I think 
you can handle this part of the project solo. Just remember, 
when you set up a mask layer, it will only include 1 layer 
underneath to be masked. For the rest of the layers, you’ll 
need to drag them in to be masked.  
 
On the next page, I’ll show you my version with some extra 
notes on ideas you can try. 

65

Spikes in the Audio WaveWhoosh Sound

http://www.cartoonsmart.com/Animation_Book1/resources.php5
http://www.cartoonsmart.com/Animation_Book1/resources.php5


66

Movie 2.17 Tap above to play or here to view in a browser

http://www.cartoonsmart.com/Animation_Book1/book_movie.php5?movieFile=Movie_2_17_title_sequence&w=1280&h=720
http://www.cartoonsmart.com/Animation_Book1/book_movie.php5?movieFile=Movie_2_17_title_sequence&w=1280&h=720


Before we take a look at our finished motion poster, we need to 
actually...well, finish it. Although, many Hollywood-produced 
motion posters stay looping endlessly (for example, the recent 
one for Catching Fire), I think ours could use a little more of a 
“hook” before we fade out and officially declare it done. How 
about we up the threat to our mafia boss and include an audio 
file of a car peeling away loudly mixed with some tommy-gun 
fire. It sounds like a clip from a 1940’s gangster movie, but it 
should work here too. 

Import the file called car_peel_off.aif from the usual zip file of 
resources to the Flash file’s 
library. 

Now on the existing layer called 
“car peel off”, or any new layer 
above the current layers, draw 
a yellow rectangle aiming 
towards the side wall of the 
freeway. Once you’ve shaped it 
into place, convert it to a Movie 
Clip and add a yellow Glow 
filter to it. My settings are 

BlurX: 20, BlurY: 8, Strength: 150, and Quality: High. 

Next, convert that Movie Clip to another Movie Clip and you can 
name it something like “car_peel_off_animation”. Once you’ve 
done that, you can create a new blank layer for the sound file 
(within that Movie Clip), and begin animating this half-baked 
attempt to whack the boss. In my version, I’ve created a blank 
keyframe on frame 89 to begin playing the sound file. This will 
put the tommy-gun fire starting around frame 123, which is 
where you should slide the first frame of that glowing artwork 
you just made. Underneath that streak, add a white burst to 

indicate an impact with the 
wall. This shape might look 
fancy with the white Glow 

applied, but it’s 
nothing more 
than another 
rectangle with 
new vector 
points pulled 
sharply from it. 

Section 9

Fade Out...In Style
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Dudes,
I’m fading

here... 
This wall 

feels really 
comfy...

...just need 
some bassy 
Dub-Step to 
fall asleep to.



My settings for this Glow are BlurX: 8, BlurY: 9, Strength: 330, 
and Quality: High.

After this first frame of 
cartoonish G.I. Joe style 
gunfire, you could try a second 
frame where you enlarge and 
flip the white burst and shrink 
the streak toward the same 
impact spot. Something like the 
image on the right. Keep in 
mind, these impacts are all 1-2 
frames at most, so you can be 
a bit lazy here. For example, instead of creating a second, more 
unique white burst, you can easily get away with just flipping the 
first one and increasing the size. No one will notice because these  
play through so quickly. 

Now to finish off this 
effect, let’s add an 
impact hole in the wall 
starting from whenever 
that white burst 
occurred. Add this on a 
new layer underneath 
the current art. These 
impact holes will stick 
around, whereas the 

streaks and bursts are obviously temporary frames so it’s best to 
keep them on separate layers. As you can see from the example 
image on the previous column, my impact holes are nothing 
fancy. I just drew a blank circle, then pulled new vector points 
inward. In my project, all of the holes use the same artwork, I just 
flipped them around to make them seem different. 

If you haven’t already found them, the commands to flip vertically,  
horizontally or rotate 90 degrees are under Modify > Transform. 
All of those hot keys are worth learning if you plan to use Flash 
frequently. 

Now just repeat what you already did each time you hear a shot 
from the tommy gun, and you should have something similar to 
my version, which you can check out below. 
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Fade to Black

Flash doesn’t have a built-in preset for fading to black when a 
movie finishes, so we’ll do the next best thing. We are going to 
create a black square the same size as the stage and fade it from 
0 percent Alpha to 100 percent. This square will be on our top 
most layer, so it will appear that everything is fading to black. 
Pretty simply, eh? Then, like any symbol we don’t want to loop, 
we’ll just add a stop 
action at the end. My 
fade occurs between 
frames 195 and 325, 
and during that time I 
also added some 
“Coming Soon” text 
that fades in. 

That does it for this project! My finished poster can be seen 
here. Hopefully your version looks as good, or better!   
The completed source files are included with the zip of resources 
for this chapter, named tony_finished.fla. 

If you’ve been reading the free preview of this book, stay tuned 
because there’s plenty more ahead. Notable features we haven’t 
even touched on include: the Motion Editor (and new Motion 
Tweens), 3D, Inverse Kinematics, and much more! 
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The “usual” CartoonSmart way of teaching things has always been with longer, more off-the-cuff video files, and I’d like to keep that fun 
alive even after embracing this beautiful new written format. So if you’d like to watch this chapter’s project come together in a lengthy 
video tutorial, you can tap the “Bonus Video” widget below. This is a streaming video, so you’ll need an internet connection to view it. 

Section 10

Long-Play Bonus Video
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Chapter 3

Coming Soon 

Thanks for checking out this preview, more 
chapters are coming soon! Be the first to hear about 
updates to this book and other new tutorials by 
signing up for the newsletter at CartoonSmart.com 
(the sign up form is on the bottom of every page of 
the site)

Phew
I need a 
break

http://www.cartoonsmart.com
http://www.cartoonsmart.com


Actions Window

The Actions window is where you will write Actionscript. Open this window by hitting 
Option + F9 on a Mac or simply F9 on Windows, or from the top menu by going to 
Window > Actions. 

Related Glossary Terms

Index

Chapter 2 - City Noise

Actionscript 3, Random frame

Find Term



Actionscript 3

The most recent version of Flash’s scripting language is Actionscript 3. The advantage of 
writing your code with Actionscript 3 (or AS3 for short) is that you can package your project 
as an iOS, Android, or AIR application. Your AS3 code will be written in the Actions 
Window. 

Related Glossary Terms

Index

Chapter 2 - City Noise

Actions Window, Random frame

Find Term



Adding an extra vector point

While using the Selection tool, hold down the Option key on the Mac or the Ctrl key on a 
PC and click-drag on the side of a vector shape. This will create a new vector point in the 
shape. 

Related Glossary Terms

Index

Chapter 2 - Key-Framing Freeway Lights

Drag related terms here

Find Term



Break Apart

The Break Apart command (found in the Modify menu) will break a symbol down to 
whatever it contains (on frame 1). So if your symbol contained vector art, you would be left 
with vector art. If the symbol you broke apart contained layers of other symbols, you would 
be left with all those symbols (on top of each other on one layer). 

The Break Apart command can also be used on Text. Break Apart will first divide text into 
individual letters, and if you broke apart those, you would convert the text to vector 
artwork. Which can be very useful.

You can also Break Apart bitmaps to a vector shape. Once that shape is larger than the 
image, it will repeat. So you could use this to make tiled patterns. 

Related Glossary Terms

Index

Chapter 2 - Masks and Tweens

Drag related terms here

Find Term



Classic Text

Classic text is the name for the older text engine in Adobe Flash. 

Related Glossary Terms

Index

Chapter 2 - Title Animation (and a Blink)

TLF Text

Find Term



Classic Tween

Classic tweens are a simplified version of the (relatively) new Motion Tweens in Flash. When 
using a Classic Tween each keyframe is marking the position, rotation, scaling, skew, color 
effect, filters, etc all at once. So even if the only property you changed was the position, the 
other properties have been keyed on those frames. Usually that’s fine though. The 
advantage of the newer Motion Tweens is those properties can be shifted independently of 
one single keyframe. So even though the Classic Tween is easy, it’s less flexible if we want 
to change many different properties during a certain time span.

Related Glossary Terms

Index

Chapter 2 - Masks and Tweens

Drag related terms here

Find Term



Clear Frames

Clear Frames will move an existing frame forward (keying it if there wasn’t a key before), 
and leave a blank keyframe in it’s place. Right-clicking on the timeline will give you the 
Clear Frames option.

Related Glossary Terms

Index

Chapter 2 - Smoky Shape Tweens

Clear Keyframe

Find Term



Clear Keyframe

Clear Keyframe will remove a key frame. Not to be confused with Clear Frames, which is 
a bit different. Right-clicking on a keyed frame will give you the Clear Keyframe option.

Related Glossary Terms

Index

Chapter 2 - Smoky Shape Tweens

Clear Frames

Find Term



Convert Lines to Fills

With a Line (or Stroke) piece of artwork selected, you can go to the Modify menu > Shape 
> Convert Lines to Fills, and do exactly what the command describes. Line artwork will 
become a fill. This is useful in illustration for many reasons, one reason would be to make a 
uniform line become tapered at one end.

Related Glossary Terms

Index

Chapter 2 - Masks and Tweens

Drag related terms here

Find Term



Copy/Paste Frames

No animator can do without this. Right-click on a frame to find the Copy option, and right-
click on the timeline to paste that same frame elsewhere. You can also select a group of 
frames and copy/paste them all.

Related Glossary Terms

Index

Chapter 2 - Key-Framing Freeway Lights

Drag related terms here

Find Term



Create Shape Tween

Create Shape Tween is the command found by right-clicking between frames of vector 
artwork (not symbols). This will add a shape tween to the timeline.

Related Glossary Terms

Index

Chapter 2 - Smoky Shape Tweens

Shape tweens

Find Term



Cut-out style animation

Traditional cut-out style animation is exactly what it sounds like, “cut-out” pieces of art (like 
with scissors) are moved around each frame in small steps to save time drawing those 
same parts again. 

Flash could be considered a cut-out style animation program because symbols, or reusable 
containers of art, can play a big part in your project. These symbols are similar in nature to 
cut-out pieces of art, and stored in a Library to use at anytime.

Related Glossary Terms

Index

Chapter 2 - Introduction to Flash

Drag related terms here

Find Term



Duplicate Symbol

In Flash, the Duplicate Symbol command is uniquely different than copying and pasting a 
symbol or using the confusingly-named Duplicate command.  Duplicate Symbol creates a 
unique copy of that symbol in the Library. Altering this new symbol would have no effect on 
the original symbol (or copies of that symbol).  

You can find this command by going to Modify > Symbol > Duplicate Symbol

Related Glossary Terms

Index

Chapter 2 - Introduction to Flash

Graphic Clips, Instance, Movie Clips, Symbols

Find Term



Ease

In Flash, you can set the Ease property of a shape or classic tween in the Tweening panel 
of the Properties window (once a frame of the tween is selected on the timeline). An Ease 
value of -100 is fully eased in, and a value of 100 is fully eased out.

Related Glossary Terms

Index

Chapter 2 - City Noise

Eased in, Eased out

Find Term



Eased in

If your tween of an object was eased in from one keyframe to the next keyframe, the object 
would start slower, and appear to end more abruptly. Smaller increments of movement 
would start the animation. 

Related Glossary Terms

Index

Chapter 2 - City Noise

Ease

Find Term



Eased out

If your tween of an object was eased out from one keyframe to the next keyframe, this 
would mean the object would slow down before hitting the final position, and appear to 
start faster. In other words, larger increments of movement would start the animation.

Related Glossary Terms

Index

Chapter 2 - City Noise

Ease

Find Term



Edit a Selected Symbol

After you’ve created either a Movie Clip or Graphic Clip the content within is not set in 
stone. Simply press the well-worth-memorizing keyboard shortcut Command/Ctrl + E 
(Command for the Mac, Control for Windows) or double-click the symbol to edit it. After 
doing so, just remember the timeline you now see belongs to that symbol. To jump back to 
the main scene (or main timeline), use the same hot key or double-click outside of the 
symbol’s contents. 

Related Glossary Terms

Index

Chapter 2 - Introduction to Flash

Shortcut Command/Ctrl + E

Find Term



Edit Envelope

The window gives you a close up view of the audio file you have selected. You can zoom in 
or out on to get a better view of the wave file.  The Left channel is depicted as the top 
wave, the Right is the bottom wave. You can edit control handles to make changes to the 
volume on a per channel basis. You can also trim the clip to shorten it or fine tune how it 
repeats.

Related Glossary Terms

Index

Chapter 2 - Adding & Altering Sounds

Drag related terms here

Find Term



Edit Multiple Frames

The often-overlooked Edit Multiple Frames button on the timeline let’s you manipulate 
multiple frames at once using handle bars that appear above the timeline to select them. 
You can reposition those frames, color them, add Filters, set Blends, scale, skew or rotate 
them all at once. 

Related Glossary Terms

Index

Chapter 2 - Key-Framing Freeway Lights

Drag related terms here

Find Term



Event (audio)

Flash has two very important Sync settings in the Sound panel: Event and Stream. With 
the Event setting the entire audio clip will play when the timeline plays (or stops on) the 
keyframe with that sound.  

Related Glossary Terms

Index

Chapter 2 - Adding & Altering Sounds

Stream (audio)

Find Term



Flash Player

Within a web browser the Flash Player is a plugin that plays Flash-authored .swf files. As a 
Flash developer you also have a standalone Flash Player application. Flash Player is not 
installed on iOS devices, so animations you create using Flash need to be exported to a 
movie format like .mov or .m4v prior to viewing them on iPhones or iPads. Android devices 
usually have the Flash plugin installed.  

Related Glossary Terms

Index

Chapter 1 - What Program Are We Using?

Drag related terms here

Find Term



Free Transform Tool

The Free Transform Tool found on the toolbar under the black Select Arrow (or by pressing 
Q) will scale, rotate or skew vector artwork or symbols. 

Related Glossary Terms

Index

Chapter 2 - Key-Framing Freeway Lights

Shortcut Q

Find Term



Gradient Transform Tool

The Gradient Transform Tool can be found on the toolbar as a pulldown underneath the 
Free Transform Tool (or simply press the F key on the keyboard). This tool let’s you 
change how a gradient is applied to your Fill shape. To experiment with this, use one of the 
default gradient swatches (on the bottom row of swatches when using the color picker). 
Select the Fill shape with the gradient with the Gradient Transform Tool. You should see 
handles appear (either Linear or Circular handles depending on the gradient style), move 
those handles to change how the gradient is applied. 

Related Glossary Terms

Index

Chapter 2 - Smoky Shape Tweens

Shortcut F

Find Term



Graphic Clips

When creating a symbol you have three options: Graphic, Movie Clip, or Button (which 
we’ll ignore in this book). For animation, your choice comes down to Graphic or Movie Clip. 
Both options create a symbol in the Library which can be dragged back on stage and used 
whenever you like (think of that one like the master, or original copy). If you were to change 
the contents inside any copy of either a Graphic or Movie Clip this change would occur on 
ALL instances, or copies of that same symbol, including the original in the Library. To make 
a unique version, see the related entry on Duplicate Symbol.

Some pros and cons of using a Graphic Clip over a Movie Clip are noted below...

Movie Clip Graphic Clip

Can loop Yes Yes

Can loop if the main timeline is 
stopped at a single frame. Yes No

Scrubbing the main timeline will show 
animation within the symbol No Yes

Can have Filters or  
Blending applied to it Yes No

Exports to a PNG Sequence Pre-CS6: No  
CS6: Yes Yes

Exports to a Quicktime Movie Yes Yes

Can start at a frame other than 1 Yes /w code Yes

Can be controlled with Actionscript Yes No

Related Glossary Terms

Index

Chapter 2 - Introduction to Flash

Duplicate Symbol, Movie Clips, Shortcut F8, Symbols

Find Term



Insert Blank Keyframe

To insert a blank keyframe you could press F7 or right-click on the timeline and select 
Insert Blank Keyframe. This will clear out that frame (if existing content was on that layer), 
and leave a blank marker essentially for new content to be drawn or pasted onto that 
frame.

Related Glossary Terms

Index

Chapter 2 - Introduction to Flash

Shortcut F7

Find Term



Insert Frame

To add another frame or frames on the timeline select one or more frames, then right-click 
and select Insert Frame or just press F5.  This will extend the current layer’s time length by 
however many frames you selected. Note, that you aren’t adding a keyframe, you are 
simply adding more time to that layer. 

Related Glossary Terms

Index

Chapter 2 - Introduction to Flash

Shortcut F5

Find Term



Insert Keyframe

To insert a keyframe, select the frame or frames on the timeline you want to key, then right-
click and select Insert Keyframe, or simply press F6. You can key either vector art work or 
symbols. 

Related Glossary Terms

Index

Chapter 2 - Introduction to Flash

Shortcut F6

Find Term



Instance

An instance refers to a copy of a symbol. Instances all contain the same contents, so if 
something was changed/removed from the inside of one instance of a symbol, this change 
would occur to all the instances, including the original symbol in the Library. To make a 
unique copy (one that won’t alter other instances), select the symbol and go to Modify > 
Symbol > Duplicate Symbol. See the related glossary term for more info.

Related Glossary Terms

Index

Chapter 2 - Introduction to Flash

Duplicate Symbol

Find Term



Library

The Library window is where you’ll find imported items, like sounds or images, and any 
symbols you’ve created. Use the shortcut Command/Ctrl + L or go to Window > Library. 
Items in the Library can be dragged onto the stage.

Related Glossary Terms

Index

Chapter 2 - Introduction to Flash

Symbols

Find Term



Loop (audio)

You can choose to Repeat or Loop audio files. Loop is endless, Repeat gives you the 
option to set a number of times to replay the sound. Setting it to 1 (or 0) just plays the audio 
once. Any number higher than 1, plays the sound that many times.

Related Glossary Terms

Index

Chapter 2 - Adding & Altering Sounds

Repeat (audio)

Find Term



Mask

A Mask layer will prevent artwork or symbols in the layer below it (the layer being masked) 
from being seen outside of a defined area (what’s drawn on the Mask layer). For more 
details and a video example, see the section of the book on masking. 

Related Glossary Terms

Index

Chapter 2 - Masks and Tweens

Drag related terms here

Find Term



Movie Clips

When creating a symbol you have three options: Graphic, Movie Clip, or Button (which 
we’ll ignore in this book). For animation, your choice comes down to Graphic or Movie Clip. 
Both options create a symbol in the Library which can be dragged back on stage and used 
whenever you like (think of that one like the master, or original copy). If you were to change 
the contents inside any copy of either a Graphic or Movie Clip this change would occur on 
ALL instances, or copies of that same symbol, including the original in the Library. To make 
a unique version, see the related entry on Duplicate Symbol.

Some pros and cons of using a Movie Clip over a Graphic Clip are noted below...

Movie Clip Graphic Clip

Can loop Yes Yes

Can loop if the main timeline is 
stopped at a single frame. Yes No

Scrubbing the main timeline will show 
animation within the symbol No Yes

Can have Filters or  
Blending applied to it Yes No

Exports to a PNG Sequence Pre-CS6: No  
CS6: Yes Yes

Exports to a Quicktime Movie Yes Yes

Can start at a frame other than 1 Yes /w code Yes

Can be controlled with Actionscript Yes No
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Parent symbol

A symbol holding other symbols. A parent symbol might have it’s own parent symbol.
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Pixel-based illustration

If you aren’t familiar with vector-based illustrations, then you’ve probably been working with 
bitmaps, or pixel-based illustrations (for example, if you’ve mostly used Photoshop in the 
past). This artwork is generally in a JPG or PNG format, and made up of pixels, tiny little 
squares of color. Those type images can be imported and animated in Flash, but generally 
speaking, Flash is not a pixel-based program. Illustrating in Flash creates vector artwork. 
Vectors, or points, are connected with line shapes or fill shapes (or both) to form what you 
see on stage. Vector artwork is easier to manipulate for animation, so in general, you do not 
want to rely on imported pixel-based artwork to animate in Flash. 
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Random frame

Your Movie Clips can be programmed with Actionscript 3 to jump to a random frame. Type 
the following line in the Actions Window (with a blank keyframe selected)...

gotoAndPlay(  Math.round(Math.random( ) * 9 ) + 1  );

In that example, the timeline would be sent to a random number between 1 and 10. If we 
didn’t add 1 above, the random range would be 0 to 9, and there’s no frame 0 in Flash.
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Repeat (audio)

You can choose to Repeat or Loop audio files. Loop is endless, Repeat gives you the 
option to set a number of times to replay the sound. Setting it to 1 (or 0) just plays the audio 
once. Any number higher than 1, plays the sound that many times.
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Royalty-free stock art

Basically, buyable artwork that’s been licensed for you to use. If you’re incorporating it into 
a Flash animation, it’s probably best to buy vector-based artwork, which could be in .eps 
format, .ai (Adobe Illustrator), or some sites like iStockPhoto.com even sell .fla files (Flash 
files).
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Shape tweens

Shape Tweens animate the shape of vector artwork from one state to another. Right-click 
on the timeline between two keyframes of vector art (not symbols) and select Create 
Shape Tween. Tweening similar shapes, like those with equal vector points, will usually 
animate a more “usable” transformation. If Flash needs to add or delete vector points from 
one keyframe to the next, you can get some unexpected results (blobby shapes). 
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Shortcut A

Depending on your version of Flash (or personal hot key preferences), pressing A will 
choose either the Select tool (the icon with the black arrow) or Subselection tool (the icon 
with the white arrow). 
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Shortcut Command/Ctrl + 1

Pressing shortcut Command/Ctrl + 1, sends the stage back to viewing your art at 100% 
zoom (Command on the Mac, Ctrl on Windows).
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Shortcut Command/Ctrl + 2

Pressing shortcut Command/Ctrl + 2, zooms the stage to fill your current work area. 
(Command on the Mac, Ctrl on Windows).

Related Glossary Terms

Index

Chapter 2 - Introduction to Flash

Drag related terms here

Find Term



Shortcut Command/Ctrl + E

With a symbol selected this will bring up Edit Mode, which brings you within that symbols 
timeline to edit it’s contents. 
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Shortcut Command/Ctrl + G

This is the default hot key for Group, BUT I recommend new users to Flash, ignore 
grouping anything until they have fully understood the benefits of using symbols. So I 
recommend switching this hotkey to something like Swap Symbol instead. 
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Shortcut F

This shortcut switches to the Gradient Transform Tool, and for any of you illustrating a lot 
in Flash, this is a hot key worth remembering.
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Shortcut F5

Inserts frames on the timeline, which adds time (not keyfames).
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Shortcut F6

Adds a keyframe or keyframes to the timeline. 

Related Glossary Terms
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Shortcut F7

Inserts a blank keyframe or blank keyframes to the timeline.

Related Glossary Terms
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Shortcut F8

Converts whatever you have selected to a symbol. This could be vector artwork, another 
symbol, multiple symbols, or an image. Anything really. 

Related Glossary Terms

Index

Chapter 2 - Introduction to Flash

Graphic Clips, Movie Clips, Symbols

Find Term



Shortcut Q

This shortcut switches to the Free Transform Tool, and for anyone using Flash for more 
than about 10 minutes, this is a hot key worth remembering. Something always needs 
either a skew, scale or rotate. 

Related Glossary Terms

Index

Chapter 2 - Key-Framing Freeway Lights

Free Transform Tool

Find Term



Shortcut to play the timeline

Pressing the Enter key on Windows or the Return key on the Mac is a shortcut to play the 
timeline (if you have more than one frame). 
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Shortcut to step forward or backward

The shortcuts to step one frame forward or backward on the timeline use either the < key or 
> key (the keys with the less than or greater than symbols, aka, the comma and period 
keys). 
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Shortcut to test publish movie

Pressing Control + Enter on Windows or Command + Return on the Mac is a shortcut to 
test publish movie. You could also do this by going to the Control menu and finding Test 
Movie. This is drastically different than just playing the timeline, because you’re actually 
publishing a .swf file and previewing it. Code would run, and more importantly for us 
animators, Movie Clips would play normally. 
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Shortcut V

Depending on your version of Flash (or personal hot key preferences), pressing V will 
choose either the Select tool (the icon with the black arrow) or Subselection tool (the icon 
with the white arrow).
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Shortcut Z

Switches to the Zoom / Magnifier tool. Like most other programs this tool can be used to 
zoom in or out by pressing a modifier key, on the Mac this is the Option key, on Windows 
this is Control. 
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Sound Effect Menu

When an audio file is selected on the timeline, the Properties window will give you some 
preset Effect options to change the audio.

• Left Channel - plays only the left channel.

• Right Channel - plays only the right channel.

• Fade to right - this effect spans the entire length of the clip, beginning with the right 
channel off and the left channel on, then fading out the left while fading up the right. 

• Fade to left - this effect spans the entire length of the clip, beginning with the left channel 
off and the right channel on, then fading out the right while fading up the left. 

• Fade in - fades in the beginning quarter of the track.

• Fade out - fades out the last quarter of the track.

• Custom - gives you custom control of the playback of each channel. 
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Static

Un-animated, or not moving.
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Stop Action

Your Movie Clips can be programmed with Actionscript 3 to stop at any frame. Type the 
following line in the Actions Window (with a blank keyframe selected)...

stop ( );

When published, your Movie Clip would now stop at whatever frame this appeared at. 
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Stream (audio)

Flash has two very important Sync settings in the Sound panel: Event and Stream. With 
the Stream option, the movie must be playing to hear whatever part of the audio file you 
can see in wave form on the timeline.
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Swap Symbol

Exchange one symbol for another by right-clicking on a symbol and finding Swap Symbol 
or go to Modify > Symbol > Swap Symbol. You can then pick out any other symbol in the 
Library to replace the current one on stage in the same position. This is very useful for 
animating events like a lip sync, where you have multiple mouth shapes of similar size in 
the Library.
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Swf file

Flash’s native publishing format. When you test publish your movie, you will also create 
a .swf file, which resides in the same place as your .fla file. Usually with accompanying 
html embed code, the .swf would be uploaded to your server or webpage to be viewed.
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Symbols

Flash has two primary containers for your artwork. These are Movie Clips and Graphic 
Clips, which can both be called Symbols in Flash. Most often when we animate 
something, we’ll want to convert the artwork to a symbol first. This could be done by 
selecting the vector art and tapping the keyboard shortcut F8.

Symbols are saved in the Library window, and can be reused whenever by dragging them 
back onto the stage. 
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Timeline

Like all good animation programs, Flash has a Timeline so we can change things over 
time. That’s a no-brainer, right? Your stage, or main scene, in Flash has a primary timeline, 
but every Symbol also has it’s own timeline.  So your main timeline, might be stopped at 
frame 1 after publishing, but Movie Clip symbols could be playing / looping their own 
timelines accounting for the animation you see on stage. The Motion Posters project does 
exactly this, the main timeline never leaves frame 1.
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TLF Text

Stands for Text Layout Framework (TLF). TLF supports a wider array of rich text layout 
features and fine control of text attributes. TLF text allows greater control of text than the 
previous text engine, now called "classic text."

Compared to classic text, TLF text provides additional character styles, including leading, 
ligatures, highlight color, underline, strikethrough, case, digit case, and more. It also 
includes additional paragraph styles, including multicolumn support with gutter width, last-
line justification options, margins, indents, paragraph spacing, and container padding 
values.
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Tradigital

Just a fun term, used to described traditional style animation using digital tools. Some 
“tradigital” Flash video tutorials are available at CartoonSmart.com in the Animation 
section.
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Vector-based illustration

Illustrating in Flash creates vector artwork. Vectors, or points, are connected with line 
shapes or fill shapes (or both) to form what you see on stage. Vector artwork is easier to 
manipulate for animation, and this book teaches many vector illustration techniques 
(especially in the video tutorials). 

Vector artwork can also be scaled up or down without any loss in quality. Whereas if you 
zoomed in on pixel based artwork, you would begin to see pixelation (the squares that 
make up what you see). Vector artwork doesn’t pixelate. This also makes vector artwork 
excellent for exporting to print media or higher resolution formats.
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Volume (control of audio)

Through the Edit Envelope window you can lower the volume of your entire clip. First 
remove any existing handles, then add one handle on each channel and place it 
somewhere between the top and bottom. You should see a straight volume line across the 
channel. 
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